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la acción de presionar uno de los botones del mouse, 

generalmente haciendo referencia al botón izquierdo. 

 

Colector  Sistema conformado por un conjunto de tuberías, pozos de 

visita, obras y accesorios, que se utilizan para la descarga 

de las aguas residuales o pluviales. 

 

Columna  Elemento estructural capaz de resistir carga axial de 

compresión y que tiene una altura de, por lo menos, tres 

veces su menor dimensión lateral. 

 

Compactación  Procedimiento  que  consiste  en  aplicar  energía  al  suelo 

suelto para consolidarlo y eliminar espacios vacíos, 

aumentando así su densidad y  su capacidad de soportar 

cargas. 

 

Cota de terreno   Altura de un punto del terreno, haciendo referencia a un 

nivel determinado, banco de marca o nivel del mar. 

 

Descarga Lugar  donde se depositan las aguas residuales que 

provienen de un colector. 

 

Desfogue  Salida de aguas residuales en un punto determinado. 
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Desinfección Eliminación de bacterias patógenas que existen en el agua 

mediante procesos químicos. 

 

Dotación    Cantidad de agua necesaria para consumo, requerida por 

una persona  en un día. 

 

Esfuerzo  Intensidad de fuerza por unidad de área. 

 

Especificaciones Normas técnicas de construcción con disposiciones 

especiales, de acuerdo con las características y tipo de 

proyecto; son de carácter específico bajo estándares de 

calidad y seguridad. 

 

ETABS Programa de computación que se utiliza en el diseño de 

edificios y otro tipo de estructuras.  

 

Excentricidad  Se produce cuando el centro de masa no coincide con el 

centro de gravedad, produciendo de esta manera esfuerzos 

adicionales por torsión. 

 

Menú En computación, es una herramienta gráfica en la interfaz 

de programas, páginas web y aplicaciones; consiste en una 

lista de opciones que puede desplegarse para mostrar más 

opciones o funciones y acceder así a las distintas 

herramientas de la aplicación. 

 

Momento  Esfuerzo debido a la aplicación de una fuerza a  cierta 

distancia de su centro de masa. 
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Perfil   Visualización en plano de la superficie de la tierra, según su 

latitud y altura, referidas a banco de marca. 

 

Pozo de visita Estructura que sirve para recibir y depositar las aguas 

residuales entre dos tuberías. Se utiliza para cambiar de 

dirección, pendiente, diámetro, y para iniciar un tramo de 

tubería. 

 

Tip Consejo y/o aviso oportuno para realizar una acción. 

 

Tramo Espacio   comprendido  entre  el  centro  de  los pozos de 

visita. 

 

UBC Uniform Building Code, código para el diseño de edificios. 

 

Valor soporte Capacidad del suelo para resistir cargas por unidad de 

área. 

 

Zapata  Estructura cuya función es transmitir la carga al subsuelo a 

una presión de acuerdo con las propiedades del suelo. 
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RESUMEN 

 

 

 

Este trabajo de graduación es el informe sobre el Ejercicio Profesional 

Supervisado realizado en la municipalidad de San Juan Comalapa, 

departamento de Chimaltenango, en el cual se plantean soluciones técnicas  y 

viables a las necesidades de la población. 

 

Está dividido en dos fases: la primera, corresponde a la fase de 

investigación, contiene una monografía del municipio, en la que se incluye 

historia, ubicación, aspectos económicos entre otros datos del lugar,  y un 

diagnóstico sobre las necesidades de servicios básicos e infraestructura del 

lugar en estudio.  

 

La segunda, fase de servicio técnico profesional, describe el diseño de dos 

proyectos, los cuales son: un proyecto de drenaje sanitario para la aldea Cojol 

Juyú; y la construcción de una pasarela a la entrada de la cabecera municipal 

de San Juan Comalapa. 

 

 El trabajo de graduación presenta los planos y presupuestos respectivos.  

 

 

 

 

 

 

 



XVI 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



XVII 
 

OBJETIVOS 

 

 

General 
 

Desarrollar una investigación monográfica y diagnóstica, sobre las necesidades 

prioritarias existentes en cuanto a servicios básicos e infraestructura en la aldea 

Cojol Juyú y cabecera municipal del municipio de San Juan Comalapa, 

departamento de Chimaltenango, y proponer soluciones con el diseño de obras 

de infraestructura que se necesitan en la comunidad. 

 

 

 

Específicos 

 

1. Diseñar el sistema de drenaje sanitario para la aldea Cojol Juyú y la 

pasarela que se instalará en la entrada a San Juan Comalapa, municipio 

de San Juan Comalapa, departamento de Chimaltenango. 

 

2. Capacitar a los integrantes del COCODE de la aldea Cojol Juyú sobre 

aspectos relacionados con la operación y mantenimiento del sistema de 

drenaje sanitario. 

 

3. Capacitar a los integrantes de la Oficina Municipal de Planificación de 

San Juan Comalapa, en relación con el diseño y mantenimiento de la 

pasarela. 
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INTRODUCCIÓN 

 

 

 

El municipio de San Juan Comalapa, que se ubica dentro del 

departamento de Chimaltenango, al igual que todos los municipios del interior 

del país, presenta grandes carencias en cuanto a infraestructura y servicios 

básicos para sus pobladores. 

 

Después de realizar un diagnóstico sobre las necesidades en 

infraestructura, se concluyó que los habitantes de la aldea Cojol Juyú necesitan 

la construcción del sistema de drenaje sanitario que dé un adecuado 

tratamiento a las aguas residuales, ya que la ausencia de este, atenta contra la 

salud de los pobladores.   

 

También se determinó que para proveer de seguridad a los peatones que 

transitan en el sector y tener una entrada estéticamente más presentable, se 

hace indispensable construir una pasarela; así se conseguiría que los carros 

puedan transitar libremente al entrar o salir del municipio, sin atentar contra la 

seguridad vial de los peatones.  

 

Por lo que este trabajo de graduación presenta el diseño de los proyectos 

anteriores adjuntando al final los resultados, consistentes en planos y 

presupuestos de ejecución. 
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1. FASE DE INVESTIGACIÓN 

 

1.1     Monografía del municipio de San Juan Comala pa 

 

     1.1.1    Reseña histórica 

 

El nombre del municipio proviene de la expresión kaqchikel “chi royal xot” 

que significa “junto a la fuente de los comales”. Después de la conquista, los 

indígenas náhuatls que acompañaban a los conquistadores lo llamaron de 

acuerdo con su propia lengua. Así comenzó a llamarse Comalapa, de comal, y 

apa que significa lugar, o sea “lugar de los comales”. 

 

En la época colonial llegaron catequistas y sacerdotes católicos a 

propagar su religión. Éstos pusieron al pueblo bajo la protección de San Juan 

Bautista y por eso se designó definitivamente como San Juan Comalapa. 

 

En la Constitución Política de la República decretada el 11 de octubre de 

1825, se da a conocer que se organizó el territorio en once distritos y varios 

circuitos. En el Distrito octavo correspondiente a Sacatepéquez aparece San 

Juan Comalapa, como cabecera de distrito.  

 

Posteriormente, al ser creado el departamento de Chimaltenango por 

Decreto de la Asamblea Constituyente de 12 de septiembre de 1839, el 

municipio de San Juan Comalapa entra a formar parte de dicho departamento, 

al cual pertenece hasta la fecha. 
 

A San Juan Comalapa se la denomina “Florencia de América”, por ser 

cuna de grandes artistas, entre los que destacan Rafael Álvarez Ovalle, autor 

de la música del Himno Nacional, y el pintor Andrés Curruchiche.  
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1.1.2 Localización del municipio 

 

El municipio de San Juan Comalapa se encuentra en el departamento de 

Chimaltenango, mismo que forma parte de la región V o región central de 

Guatemala.  Se localiza a 81 kilómetros de distancia con la ciudad de 

Guatemala, y a 30 kilómetros de la cabecera departamental. 

 

Figura 1. Mapa de localización de San Juan Comalapa  

 

 

 

 

 

 

 

 

 

 

 

 

 

Su extensión territorial es de 76 km²  y está formado por un 

pueblo, 7 aldeas, 25 caseríos y un paraje. 

 

1.1.3 Ubicación geográfica 

 

La cabecera municipal de Comalapa se ubica, de acuerdo con el banco 

de marca (BM), del Instituto Geográfico Nacional – IGN-, ubicado en el parque 

central de la localidad, a una elevación promedio de 2,115 metros sobre el nivel 
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del mar (MSNM), y se ubica en las coordenadas geográficas: latitud 14º44’24” y 

longitud 90º53’15”. 

 

1.1.4 Aspectos topográficos 

 

La topografía del terreno es quebrada, con pendientes pronunciadas, el 

terreno se encuentra muy deforestado por la tala inmoderada; actualmente 

existen campañas de reforestación por parte de la municipalidad. 

 

1.1.5 Vías de acceso 

 

El municipio de San Juan Comalapa se comunica con la ciudad capital 

por la carretera interamericana CA-1; 51 kilómetros son de autopista con 

pavimento de asfalto, hasta llegar al departamento de Chimaltenango. De la 

cabecera departamental de este lugar al municipio de San Juan Comalapa, hay 

30 kilómetros por la carretera interamericana, con pavimento de asfalto de dos 

carriles. El municipio de San Juan Comalapa cuenta con un 90% de sus calles 

adoquinadas y pavimentadas. 

 

1.1.6 Clima 

 

San Juan Comalapa posee un clima templado, en diciembre y enero la 

temperatura baja a dos grados centígrados y en abril sube a 27 grados 

centígrados; en la actualidad existen dos estaciones meteorológicas cercanas a 

este municipio, estas se encuentran situadas en Santa Cruz Balanyá y San 

Martín Jilotepeque, ambos municipios del departamento de Chimaltenango. 
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1.1.7 Colindancias  

 

Los límites del municipio son: 

 

- Norte: San José Poaquil y San Martín Jilotepeque 

- Este: San Martín Jilotepeque 

- Sur: Zaragoza, Santa Cruz Balanyá y Chimaltenango 

- Oeste: Tecpán Guatemala, Santa Apolonia y San José Poaquil. 

 

Todos los municipios limítrofes pertenecen al departamento de 

Chimaltenango. 

 

1.1.8 Demografía 

 

El área urbana está formada por 20,047 habitantes; el área periurbana 

por 4,375 y el área rural por 14,953, para un total de 39,375 habitantes. De los 

cuales un 93% de la población es maya kaqchikel y un 7% es ladina o no 

indígena.  

 

Según  el   censo   poblacional,   elaborado   por   el  Instituto Nacional de 

Estadística -INE-, San Juan Comalapa es el quinto municipio más poblado del 

departamento de Chimaltenango. 

 

El 60% de la población profesa la religión católica y el 40% la evangélica. 

 

El crecimiento desmedido de la población, es una de las mayores 

preocupaciones de las diferentes actividades, tomando en consideración que 

hay un desequilibrio entre la economía familiar como también en las limitantes 
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de los servicios básicos y la falta de fuentes de empleo, especialmente en el 

área rural. 

 

Los niveles de pobreza que posee el municipio son un 57.21% de 

personas que viven en pobreza, y un 9.77% de habitantes en extrema pobreza. 

 

1.1.9 Actividades socio-económicas 

 

En cuanto a producción agrícola, se dedican al cultivo de maíz, fríjol, 

fresa, papa, haba, arveja china, brócoli, y a la siembra de flores como gladiolas, 

claveles, rosas y otras. 

 

También se cuenta con actividad pecuaria, pues buena parte de su 

población se dedica a la cría de ganado bovino. 

 

En cuanto a producción artesanal, muchos habitantes se dedican a la 

elaboración de figuras de venados, chivos, trineos, estrellas, faroles, etc., 

utilizando como materiales: hojas de mazorca, alambres, chiriviscos, barniz, 

fibras, piezas de madera entre otros. Además, promueven artistas en la rama 

de pintura y a la industria textil artesanal: monederos, güipiles, chalecos, 

chumpas, etc. 

 

No existen fuentes permanentes de empleo en el municipio. La mayoría 

de las personas se dedican a la producción agrícola familiar y artesanal y como 

alternativa recurren a emigrar a Chimaltenango, la Ciudad Capital y sobre todo 

fuera del país. 

 

En porcentajes, las actividades se presentan así: agricultura 60%, 

artesanía 20%, comercio 20%. 
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1.1.10 Idioma 

 

Predomina el idioma español, pero paralelamente, en todas las 

comunidades del municipio se habla la lengua maya Kaqchikel. 

 

1.1.11 Servicios existentes 

 

1.1.11.1 Infraestructura vial  

 

La carretera de ingreso a la comunidad está asfaltada y existen otras 

vías de terracería que comunican con otras aldeas y municipios tales como: 

Tecpán, San José Poaquil, San Martín Jilotepeque, aldeas: Pacorral, Panabajal, 

Xenimajuyú, Cojol Juyú y otros. 

 

1.1.11.2 Servicios de comunicación 

Hay teléfonos comunitarios, teléfonos privados y telefonía móvil. El 30% 

de la población tiene teléfono en su vivienda. También el 10% de las viviendas 

tiene servicios de televisión por cable. 

 

1.1.11.3 Transporte 

 

Existen buses urbanos y extraurbanos, sin embargo hacia las zonas 

rurales, los pobladores utilizan servicios informales (pick-ups). 

 

1.1.11.4 Energía eléctrica 

 
El 94% de la población dispone de energía eléctrica. 
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1.1.11.5 Drenajes 

 
El 97% de las viviendas del casco urbano está conectado a la red de 

drenajes sanitarios, aunque el 68% descarga solamente aguas negras y el 29% 

restante, aguas negras y pluviales. 

 

1.1.11.6 Educación 

 

Existen 5 establecimientos de nivel parvulario, 15 de primaria bilingüe, 23 

de primaria, 5 básicos y 1 de diversificado. 

 

Además  de estos centros educativos, en Paraxaquen funciona una 

escuela del Programa Nacional de Autogestión Educativa -PRONADE- a la que 

asisten aproximadamente 35 alumnos. 

 

Respecto de la educación de adultos, en San Juan Comalapa, el Comité 

Nacional de Alfabetización –CONALFA- y el Instituto Guatemalteco de 

Educación Radiofónica –IGER- son las instituciones que velan por la enseñanza 

en este campo. 

 

1.2     Investigación diagnóstica sobre necesidades  de servicios 

     básicos e infraestructura del municipio  

 

1.2.1 Descripción de las necesidades  

 

- Reubicar y construir el Rastro Municipal de San Juan Comalapa, para 

solucionar la problemática de entes contaminantes dentro del casco 

urbano. Con ello, reducirían las enfermedades derivadas de malas 

prácticas de eliminación de desechos, y se reducirían los focos de 
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contaminación que pueden generarse por la ubicación del presente 

proyecto. 

 

- Construcción del sistema de drenaje sanitario de la Aldea Cojol Juyú.  

Con la construcción del servicio de drenaje sanitario se beneficiarán 176 

viviendas.  Este proyecto busca disminuir las enfermedades  como las 

alergias y/o manchas de la piel, picaduras de mosquitos, en los 

habitantes afectados, y reducir al 90% los focos de contaminación 

producidos por no contar el drenaje sanitario en todo el sector. 

 

- Construcción del Puente de Panham.  En cuanto a su naturaleza es un 

proyecto de servicios de comunicación urbano y social, vital para el 

desarrollo económico integral del municipio.  Al construir el puente, se 

crea una segunda opción de libre locomoción al ingreso del caserío de 

Panham, con lo que mejorará el egreso de productos agrícolas y 

mercantiles, incrementando el impacto económico y el desarrollo  de la 

población beneficiada, y relativamente a todo el municipio. 

 

- Construcción de pasarela a la entrada de la cabecera municipal.  Con la 

ejecución de este proyecto, se mejoraría la fluidez del tráfico vehicular a 

la entrada del municipio, y se dará mayor seguridad a los peatones que 

no pondrán en riesgo su vida al cruzar la calle. 

 

1.2.2 Priorización de las  necesidades 

 

Con la colaboración del comité se determinó que es necesario que se 

atiendan las necesidades básicas de la aldea Cojol Juyú, por lo que fue 

necesario proponer una solución consistente en una red de alcantarillado 

sanitario, por ser un servicio básico, para evitar contaminación y elevar el nivel 



9 
 

de vida de la comunidad. En segundo término, se tienen los aspectos de 

infraestructura como lo son las calles pavimentadas, centro de salud y centros 

educativos de nivel básico. 

 

Mientras que en la cabecera municipal, se determinó priorizar la 

infraestructura que contribuya al desarrollo social y económico de la comunidad, 

por lo que el proyecto a diseñar es la pasarela a la entrada del municipio. Como 

segunda prioridad está la reubicación del rastro municipal, proporcionando así 

un mejor nivel de vida de la población. 
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2. FASE DE SERVICIO TÉCNICO PROFESIONAL 

 

2.1      Diseño del sistema de drenaje sanitario pa ra la aldea Cojol Juyú 

 

2.1.1   Descripción general del proyecto 

 

El proyecto consiste en la construcción del drenaje sanitario para la aldea 

Cojol Juyú.  Posee una magnitud 2,513.99 metros, y busca evitar las 

enfermedades y problemas que conlleva la ausencia de una adecuada 

disposición de las aguas residuales. 

 

El proyecto se diseñará para una vida útil de 30 años, y beneficiará a 176 

familias que actualmente habitan la aldea. 

 

2.1.2   Levantamiento topográfico 

 

 2.1.2.1   Altimetría 

 

El levantamiento que se realizó para este proyecto fue  de primer orden 

por tratarse de un proyecto de drenajes, debido a que es importante la precisión 

de los datos obtenidos.   

 

Con los datos de campo, se obtuvieron las elevaciones y pendientes que 

existen por donde pasará el alcantarillado. 

 

 2.1.2.2   Planimetría 

 

El levantamiento planimétrico, sirve para localizar la red dentro de las 

calles, ubicar los pozos de visita y en general ubicar todos los puntos 
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importantes.  Para este proyecto se utilizó el método de conservación del 

azimut con vuelta de campana.  

 

 

 2.1.3   Descripción del sistema a utilizar 

 

Existen tres tipos de alcantarillados.  La decisión sobre cual se utilizará, 

depende de las necesidades, topografía, factor económico, y otros factores.   

 

a) Alcantarillado sanitario: recoge las aguas servidas domiciliares, como, 

baños, cocinas, lavados y servicios; las de residuos comerciales, como, 

restaurantes y garages; las de residuos industriales, e infiltración. 

 

b)    Alcantarillado pluvial: recoge únicamente las aguas de lluvia que 

concurren al sistema. 

 

c)  Alcantarillado combinado: posee los caudales de las aguas antes 

mencionadas (sanitario y pluvial). 

 

En este caso se diseñará un sistema de alcantarillado sanitario, porque 

sólo se recolectarán aguas servidas domiciliares. 

 

 2.1.4   Partes de un alcantarillado 

 

 2.1.4.1   Colector 

 

Es el conducto o tubería principal por el que se transportarán las aguas 

negras.  Se ubica comúnmente en el centro de las calles. Transporta todas las 

aguas servidas provenientes de las edificaciones hasta su destino final, ya sea 
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hacia una planta de tratamiento o un cuerpo receptor. Generalmente son tubos 

de secciones circulares, de PVC o concreto. El trayecto, comúnmente 

obligatorio, es subterráneo. 

 

  2.1.4.2  Pozos de visita 

 

Son dispositivos que permiten verificar el buen funcionamiento de la red. 

Permite efectuar operaciones de limpieza y mantenimiento, accediendo a 

realizar funciones como conectar distintos ramales de un sistema o iniciar un 

ramal. 

 

Existen pozos prefabricados hechos de materiales plásticos, aunque los 

más comunes son hechos de ladrillo. La construcción de los pozos está 

regulada por normas hechas por instituciones encargadas de velar por la 

adecuada construcción de sistemas de alcantarillado sanitario.   

 

Sus principales características son: fondo de concreto reforzado, paredes 

de mampostería o cualquier material impermeable, repellos y cernidos liso en 

dichas paredes, tapadera que permite la entrada al pozo de un diámetro entre 

0.60 a 0.75 metros, escalones que permiten bajar al fondo del pozo de hierro 

empotrados en la paredes  del pozo. La altura del pozo dependerá del diseño. 

 

 Son de secciones circulares y con diámetro mínimo de 1.20 m, 

construidos generalmente de ladrillo o cualquier otro material que proporcione 

impermeabilidad y durabilidad dentro del período  de diseño. 
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Figura 2. Pozo de visita 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  2.1.4.3   Conexiones domiciliares 

 

Tienen el propósito de descargar todas las aguas provenientes de las 

edificaciones y conducirlas hacia el colector o alcantarillado central. Consta de 

las siguientes partes: 

 

a) Caja o candela 

 
Es una estructura que permite la recolección de las aguas provenientes 

del interior de las edificaciones. Pueden construirse de diferentes formas, tales 

como:  
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• un tubo de concreto vertical no menor de 12 pulgadas de 

diámetro,   

• una caja de mampostería de lado no menor de 45 centímetros, 

impermeabilizado por dentro.  

 

Tendrá una tapadera que permita inspeccionar y controlar el caudal; el 

fondo debe  estar fundido y con un desnivel para que las aguas fluyan por la 

tubería secundaria y puedan ser transportada hacia el colector, con altura 

mínima de la candela de 1.00 metro. 

 

b) Tubería secundaria 

 
Es la tubería que permite la conexión de la candela domiciliar con el 

colector principal, conduciendo las aguas residuales que se reciben del interior 

de las viviendas. Deberá utilizarse tubo PVC de 4”, con pendiente mínima de 

2%, considerando las profundidades de instalación.  

 

2.1.5   Periodo de diseño 

 

Para empezar el diseño de un alcantarillado, se debe establecer el 

periodo por el cual se prestará el servicio de manera efectiva, pudiendo 

proyectarlo para realizar su función en un período de 20 a 40 años, a partir de la 

fecha que se realice el diseño, y tomando en cuenta las limitaciones 

económicas y la vida útil de los materiales, lo cual se puede determinar 

mediante normas hechas por el INFOM. 

 

Para el diseño del presente proyecto, se tomó un período de 30 años, 

tratando de satisfacer al máximo las necesidades de la población y tomando en 

cuenta la vida útil de los materiales. 
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2.1.6   Población futura 

 

La vida útil del proyecto dependerá del diseño, el cual se hará de 

acuerdo con la población futura.  Para determinar el número de pobladores a 

servir en el futuro, se recomienda utilizar el método geométrico pues es el que 

más se asemeja al crecimiento de la población de Guatemala. 

 
nr)(1*Po   Pf +=  

Donde: 

Pf = población futura 

Po = población actual según censo realizado en el E.P.S.   

r = tasa de crecimiento poblacional (%)                                

n = período de diseño (años)                                                        

 

El periodo de diseño es de 30 años.  Según datos del INE r = 3.5%, y 

considerando 6 habitantes por familia, 

Po = 176*6 = 1,056 hab. 

Sustituyendo valores: 

Pf = 1056* (1 + 0.0350)30 

Pf = 2,964 habitantes 

       

2.1.7   Determinación de caudal 

 

Para determinar el caudal de aguas negras del colector principal se 

realizan diferentes cálculos de caudales y se aplican diferentes factores, como 

la dotación, estimación de conexiones ilícitas, caudal domiciliar, caudal de 

infiltración, caudal comercial y, principalmente las condiciones socioeconómicas 

de los pobladores del lugar, para determinar el factor de retorno del sistema. 
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 2.1.7.1   Población tributaria 

 

La población que aportará caudales al sistema se calcula con los 

métodos de estimación de población futura generalmente empleados en 

Ingeniería Sanitaria. Se sabe que se deberá de darle el servicio a 176 familias, 

es decir 176 viviendas. 

 

 2.1.7.2   Dotación 

 

Los factores que se consideran en la dotación son: clima, nivel de vida, 

condiciones socioeconómicas, actividad productiva, abastecimiento privado, 

servicios comunales o públicos, facilidad de drenaje, calidad de agua, medición, 

administración del sistema y presión del mismo. 

 

La dotación estimada para este proyecto, tomando en cuenta los valores 

que estipula el INFOM de abastecimiento para áreas rurales, fue de 120 

lts/hab/día. 

 

 2.1.7.3   Factor de retorno al sistema 

 

En las viviendas el agua tiene diferentes usos. Todos esos usos han sido 

cuantificados por diferentes instituciones,  como la Asociación Guatemalteca de 

Ingenieros Sanitarios y Ambientales, y la Escuela Regional de Ingeniería 

Sanitaria y Recursos Hidráulicos, las que han establecido datos en lo que se 

refiere a factores de consumo de agua que se dirige directamente al sistema de 

alcantarillado. 

 

Los valores determinados por estas instituciones, del total de agua que 

se consume dentro de las viviendas, de un setenta a un noventa  por ciento se 
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descarga al drenaje, lo cual constituye el caudal domiciliar. En el  presente 

proyecto se utilizará un valor de ochenta por ciento (0.80). 

 

 2.1.7.4   Caudal sanitario 

 

2.1.7.4.1  Caudal domiciliar 

 

Es la cantidad de agua que se desecha de las viviendas, por consumo 

interno hacia el colector  principal; estando relacionada directamente con el 

suministro de agua potable en cada hogar. 

 

El agua utilizada en jardines,  lavado de banquetas, lavado de vehículos, 

etcétera  no es introducida al sistema de alcantarillado, de tal manera que el 

valor del caudal domiciliar está afectado por un factor de retorno de 0.80 para el 

presente informe, como se mencionó anteriormente, quedando el caudal total 

integrado de la siguiente manera: 

 

86400

.*..*. HabRFDot
Qdom=             

Donde: 

Qdom                     = Caudal domiciliar (l/s) 

Hab.                       = Número de habitantes futuros del tramo 

Dot.                        = Dotación (lts/hab/día) 

F. R.                       = Factor de Retorno 

86,400                    = Constante 

Sustituyendo valores 

l/s 3.29     
86400

2964*0.80*120
  Qdom ==   
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 2.1.7.4.2  Caudal industrial 

 

Es el agua proveniente del interior  de todas las industrias existentes  en el 

lugar, como procesadores de alimentos, fabrica de textiles,  licoreras, etc. 

Puesto que la aldea carece de ellos, no se contempla caudal industrial alguno. 

 

2.1.7.4.3  Caudal comercial 

 

Conformado por las aguas negras resultantes de las actividades de los 

comercios, comedores, restaurantes, hoteles; como la aldea carece de ellos, no 

se contempla caudal comercial alguno. 

 

2.1.7.4.4  Caudal por conexiones ilícitas 

 

Es la cantidad de agua de lluvia que entra al drenaje, proveniente 

principalmente porque algunos usuarios, conectan las bajadas de aguas 

pluviales al sistema.  

 

Este caudal daña el sistema y debe de evitarse para impedir la posible 

destrucción del drenaje.  Se calcula de varias formas, como un porcentaje del 

total de conexiones, o como una función del área de techos y patios, y de su 

permeabilidad, así como de la intensidad de lluvia.  

 

En este caso se tomó como base el método dado por el INFOM, el cual 

especifica que se tomará el 10% del caudal domiciliar; sin embargo en áreas 

donde no hay drenaje pluvial se podrá utilizar un valor más alto, por lo que se 

usó un 25%; quedando el caudal por conexiones ilícitas total integrado de la 

siguiente manera: 
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 l/s  0.82 3.29*0.25Q*25%  Q   Domcilicitas ===    

 

2.1.7.4.5  Caudal por infiltración 

 

Es el caudal que se infiltra en el alcantarillado, el cual dependerá del 

nivel freático del agua, de la profundidad  y tipo de la tubería, de la 

permeabilidad del terreno, el tipo de juntas y la calidad de mano de obra. 

 

Para este estudio no se tomará en cuenta, ya que en el diseño se 

utilizará tubería de PVC, y este material no permite infiltración de agua. 

 

 2.1.7.5   Caudal medio 

 

Se obtiene mediante la suma de todos los caudales provenientes de las 

industrias, comercios, viviendas, conexiones ilícitas e infiltración, descartando 

todo aquel caudal que, dada la situación o propiedades de la red, no contribuya 

al sistema; se obtiene su valor de la siguiente ecuación. 

 

Qmed   = Qdom + Qind + Qcom + Qcilicitas + Qinf        

Qmed   = Qdom + Qilicitas 

Qmed   = 3.29 + 0.82 = 4.11 l/s. 

 

 2.1.7.6   Factor de caudal medio 

 

Este factor regula la aportación del caudal en la tubería.   Se considera 

como la suma de los caudales doméstico, de infiltración, por conexión ilícita, 

comercial e industrial.  Este factor según el –INFOM- debe estar entre los 

rangos de 0.002 a 0.005.  Si da un valor menor se tomará 0.002, y si fuera 

mayor se tomará 0.005.  
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Se determina mediante la siguiente ecuación: 

0.001387    
2964
4.11      

habitantes No.
Qmedio

fqm ===  

 
Por lo que se utilizará el valor de 0.002 como factor de caudal medio para  

todos los tramos. 

 

2.1.7.7  Factor de Harmond 

 

También  llamado factor de flujo instantáneo, es el factor que se encarga 

de regular un valor máximo de las aportaciones por uso doméstico, 

determinando la probabilidad del número de usuarios que estarán haciendo uso 

del servicio o la probabilidad de que múltiples artefactos sanitarios de las 

viviendas se estén usando simultáneamente. Estará siempre en función del 

número de habitantes localizados en el tramo de aporte y su cálculo se 

determina mediante la fórmula de Harmond:  

 

47.3
1000/29644
1000/296418      

1000/4
1000/18 =









+
+=









+
+=

P
PFH  

Donde P es la población, expresada en miles. 

 
El factor de Harmond es adimensional y se encuentra entre los valores 

de 1.5 a 4.5, según sea el tamaño de la población a servir del tramo. 
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2.1.7.8   Caudal de diseño 

 

Es el que se determina para  establecer qué cantidad de caudal puede 

transportar el sistema en cualquier punto del recorrido de la red, siendo este el 

que establecerá las condiciones hidráulicas sobre las que se realizará el diseño 

del alcantarillado. 

 

Debe calcularse para cada tramo del sistema, calculado con la ecuación: 

tesNo.habitan*FH*fqmQDISEÑO =  

Donde: 

QDISEÑO  = Caudal de diseño (l/s) 

fqm   = Factor de caudal medio 

FH   = Factor de Harmond 

No. Habitantes = Número de habitantes contribuyentes a la tubería 

 

l/s 20.572964*3.47*0.002Q DISEÑO ==  

 

2.1.8   Fundamentos hidráulicos 

 

El principio hidráulico para el funcionamiento del sistema de 

alcantarillado sanitario es transportar las aguas negras por tubería como si 

fuese canales abiertos, funcionando por gravedad, y cuyo flujo está 

determinado por la rugosidad del material, y por la pendiente del canal. 

 
Particularmente para sistemas de alcantarillado sanitarios, se emplean 

canales circulares cerrados, y para no provocar ninguna molestia se construyen 

subterráneos, estando la superficie del agua afectada solamente por la presión 

atmosférica y por muy pocas presiones provocadas por los gases de la materia 

en descomposición que dichos caudales transportan. 
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 2.1.8.1   Ecuación de Manning para flujo en canale s 

 
Para encontrar valores que determinen la velocidad y caudal que se 

conducen en un canal, desde hace años se han propuesto fórmulas 

experimentales, en las cuales se involucran los factores que más afectan el flujo 

de las aguas en el conducto. Se han desarrollado fórmulas según existe un 

coeficiente C, el cual es tomado como una constante que depende de la 

rugosidad del material usado 

 

La ecuación de Manning se define así: 








=
n

S*RV
1/2

 

Donde:       

V = Velocidad  (m/s) 

R = Radio hidráulico 

S = Pendiente del canal 

n = Coeficiente de rugosidad (según material) 

 

  2.1.8.2   Relaciones de diámetro y caudal 

 

Las relaciones de diámetros y caudales que se deben tomar en cuenta  

en el diseño de la red de alcantarillado sanitario son: la relación d/D debe de ser 

mayor o igual a 0.10 y menor o igual a 0.75, y el caudal de diseño  tiene que ser 

menor al caudal a sección llena en el colector, tomando en cuenta que estas 

relaciones se aplicarán sólo para sistemas de alcantarillado sanitario. Esto es: 

 

Relación de diámetro:     75.01.0 ≤≤
D
d  

Relación de caudal:         llenasec        dis Qq 〈  
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  2.1.8.3   Relaciones hidráulicas 

 

Al realizar el cálculo de las tuberías que trabajan a sección parcialmente 

llena y poder determinar los resultados de velocidad, área, caudal, perímetro 

mojado y radio hidráulico, se relacionaron los términos de la sección totalmente 

llena con los de la sección parcialmente llena.  De los resultados obtenidos se 

construyeron las tablas que se utilizarán para el diseño de la red. 

 

 2.1.9  Parámetro de diseño hidráulico 

 

  2.1.9.1   Coeficiente de rugosidad 

 

Las empresas que fabrican tuberías para alcantarillado sanitario, realizan 

pruebas para determinar un factor para la rugosidad de la superficie interna de 

la tubería, manejando parámetros de rugosidad para diferentes materiales y 

diámetros, ya estipulados por instituciones que regulan la construcción de 

alcantarillados sanitarios. 

 

Existen valores de factores de rugosidad de algunos de las tuberías más 

empleadas en nuestro medio, entre las que se pueden citar: 

 

Tabla I. Factor de rugosidad 

MATERIAL FACTOR DE RUGOSIDAD 

Superficie de mortero de cemento 0,011-0,013 
Mampostería 0,017-0,030 

Tubo de concreto diám. < 24" 0,011-0,016 
Tubo de concreto diám. > 24" 0,013-0,018 
Tubo de asbesto cemento 0,009-0,011 
Tubería de PVC 0,006-0,011 
Tubería de hierro galvanizado 0,013-0,015 
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  2.1.9.2   Sección llena y parcialmente llena 

 

El principio fundamental de un sistema de alcantarillado sanitario como 

se ha mencionado con anterioridad, es que funciona como canales abiertos 

(sección parcial) y, nunca funcionan a sección llena. En consecuencia, el caudal 

de diseño jamás será mayor que el caudal a sección llena. 

 

Figura 3. Sección parcialmente llena 

 

o

d
D

 

 

Para el cálculo de la velocidad se emplea la fórmula de Manning. Pero 

investigaciones han derivado en la fórmula siguiente, la cual se aplica en este 

diseño: 








=
n

SDV *03429.0 3/2

               

 

Donde: 

V =   Velocidad a sección llena  (m/s) 

D =   Diámetro de tubo (pulgadas) 

S =   Pendiente del terreno (%/100) 

N =   Coeficiente de rugosidad, propiedad del tubo 

 

El caudal que transportará el tubo a sección llena, se obtiene con la 

siguiente  ecuación: 

VAQ *=                



26 
 

2*
4

DA
π=               

 

Donde: 

Q = Caudal a sección llena  (l/s) 

A =  Área de la tubería )( 2m   

V = Velocidad a sección llena  (m/s) 

π = Constante Pi 

 

Simplificando la fórmula para obtener el área directamente en 2m  en 

función del diámetro en pulgadas, se utiliza la fórmula siguiente: 

 

100*D*0.0005067Α
2=  

 

Donde: 

D = Diámetro del tubo en pulgadas 

 

  2.1.9.3   Velocidades máximas y mínimas 

 

La velocidad de  flujo se determina con factores como el diámetro, la 

pendiente del terreno y el tipo de tubería que se utilizará. Se define por la 

fórmula de Manning y por las relaciones hidráulicas de  v/V, donde  v es la 

velocidad a sección parcialmente llena y V es la velocidad a sección llena. 

 

Según las normas del fabricante,  la velocidad a sección parcial debe ser 

mayor de 0.40 m/s; con esto se evita la sedimentación en la tubería y un 

taponamiento menor o igual que 4.0 m/s, impidiendo con ello la erosión o 

desgaste. 
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  2.1.9.4   Diámetro del colector 

 

El diámetro de la tubería es una de las partes a calcular, se deben seguir 

ciertas normas para evitar que la tubería se obstruya. Las Normas del Instituto 

Nacional de Fomento Municipal –INFOM-, indican que el diámetro mínimo a 

colocar será de 8” en el caso de tubería de concreto y de 6” para tubería de 

PVC, en sistemas de drenaje sanitario.  

 

Para las conexiones domiciliares se puede utilizar un diámetro  de 6” 

para tubería de concreto y 4” para tubería de PVC, formando ángulo de 45 

grados en el sentido de la corriente del colector principal. 

 

En este caso, el diámetro mínimo de tubería utilizado para el colector 

principal fue de 6” y para las conexiones domiciliares fue de 4”, todas de tubería 

de PVC. 

 

  2.1.9.5   Profundidad del colector 

 

La profundidad a la que se colocará el colector, dependerá de la 

pendiente del terreno, la velocidad del flujo, el caudal transportado y el tirante 

hidráulico. También se debe considerar una altura mínima que permita proteger 

el sistema de las cargas de tránsito, de las inclemencias del tiempo y de 

accidentes fortuitos. 

 

De acuerdo con estudios realizados sobre cargas efectuadas por 

distintos tipos de transportes, se determinan profundidades mínimas para la 

colocación del colector, desde la superficie del terreno hasta la parte superior 

extrema de la tubería, en cualquier punto de su extensión. 
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• Tubo de concreto: 

a) Para tránsito liviano (menor a 2 toneladas) = 1.00 m 

b) Para tránsito pesado (mayor a 2 tonelada)  = 1.20 m 

 

• Tubo de PVC: 

a) Para tránsito liviano (menor a 2 toneladas) = 0.60 m 

b) Para tránsito pesado (mayor a 2 tonelada)  = 0.90 m 

 

   2.1.9.5.1   Profundidad mínima del colector 

 

Según lo estipulado anteriormente y tomando en consideración que 

existen condiciones de tránsito liviano y pesado y diferentes diámetros de 

tubería con los cuales se diseña un drenaje sanitario, se presenta una tabla que 

tabula los valores de la profundidad mínima para distintos diámetros de tubos 

de concreto y PVC. 

 

Tabla II. Profundidad mínima del colector para tube ría de concreto 

DIÁMETROS 4" 6" 8" 10" 12" 15" 18" 24"  

TRÁNSITO LIVIANO 111 117 122 128 134 140 149 165  
TRÁNSITO PESADO 131 137 142 148 154 160 169 185 Cm.  

 

Tabla III. Profundidad mínima del colector para tub ería de PVC 

DIÁMETROS 4" 6" 8" 10" 12" 15" 18" 24"  

TRÁNSITO LIVIANO 60 60 60 90 90 90 90 90  
TRÁNSITO PESADO 90 90 90 110 110 120 120 120 Cm. 

 

   2.1.9.5.2   Ancho de zanja 

 

Para llegar a las profundidades mínimas del colector se deben hacer 

excavaciones entre pozos de visita, en la dirección que se determinó en la 
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topografía.  La profundidad de estas zanjas está condicionada por el diámetro y 

altura requeridos por la tubería a colocar.  Se presenta a continuación una tabla 

que muestra anchos de zanjas aconsejables, en función del diámetro y de las 

alturas a excavar. 

 

Tabla IV. Ancho de zanja  

Diámetro en 
pulgadas 

Ancho de zanja (m) 

Para profundidades 
hasta 2,00 m 

Para profundidades  de 
2,00 a 4,00 m 

Para profundidades  de 
4,00 a 6,00 m 

4 0,50 0,60 0,70 
6 0,55 0,65 0,75 
8 0,60 0,70 0,80 

10 0,70 0,80 0,80 
12 0,80 0,80 0,80 
15 0,90 0,90 0,90 
18 1,00 1,00 1,10 
24 1,10 1,10 1,35 

 

   2.1.9.5.3   Volumen de excavación 

 

La cantidad de tierra que se removerá para colocar la tubería está 

comprendida a partir de la profundidad de los pozos de visita, el ancho de 

zanja, que depende del diámetro de la tubería que se va a instalar, y la longitud 

entre pozos, siendo sus dimensionales 3m . 

 

}{







 += Zd
HH

V **
2

21                

 

Donde: 

V = Volumen de excavación ( 3m ) 

H1 = Profundidad del primer pozo (m)  

H2 = Profundidad del segundo pozo (m) 
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 d = Distancia entre pozos (m) 

  Z = Ancho de la zanja (m) 

 

   2.1.9.5.4   Cotas Invert 

 

Es la cota de nivel que determina la colocación de la parte interior inferior 

de la tubería que conecta dos pozos de visita. Las cotas del terreno, al igual que 

los puntos de entrada y salida de la tubería en un tramo del alcantarillado, se 

calculan de la siguiente manera: 

 

  %)*.( terrenof SHDCTiCT −=                

  100*
.

%
HD

CTCTi
S

f
terreno

−=                    

  )( φ++−= TuboTrafic EHCTICII              

  cmCIFCII 03.0−=                              

  %*. TuboSHDCIICIF −=                       

  15.0−−= CIICTH ipozo                          

  15.0−−= CIFCTH fpozo                          

Donde: 

CTf = Cota del terreno final 

CTi = Cota de terreno inicial  

D.H = Distancia horizontal 

S% = Pendiente  

CII = Cota Invert de inicio 

CIF = Cota Invert final 

Htrafic = Profundidad mínima, de acuerdo con el tráfico del sector 

Etubo = Espesor de la tubería 

 Φ = Diámetro interior de la tubería 

Hpozo = Altura del pozo 
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 2.1.10   Pozos de visita 

 

  2.1.10.1   Ubicación de los pozos de visita 

 

Luego de determinar la ruta donde correrá y se ejecutará la red de 

alcantarillado, se tomará en cuenta colocar pozos de visita en los siguientes 

casos o combinación de ellos: 

 

- Donde exista cambio de diámetro 

- En intersecciones de dos o más tuberías 

- En cambio de pendiente 

- En el inicio de cualquier ramal 

- En distancias no mayores de 100 m 

- En  curvas, no más de 30 m 

 

  2.1.10.2   Profundidad de los pozos de visita 

 

La profundidad de los pozos de visita al inicio del tramo está definida por 

la cota Invert de salida; es decir, está determinada por la siguiente ecuación: 

 

HP.V = Cota del terreno al inicio – Cota Invert de salida del tramo +0.15 de base   

 

Al diseñar un sistema de alcantarillado sanitario, para determinar las 

alturas de los pozos de visita, si hubiera inconvenientes, se deben tomar en 

cuenta las consideraciones  que a continuación se mencionan: 

 
a) Cuando a un pozo de visita entra una tubería y sale otra del mismo 

diámetro, la cota invert de salida estará como mínimo 3 cm. debajo de la 

cota Invert de entrada. 
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BA φφ =                         

CInvert de salida = CInvert de entrada – 0.03   

 
b) Cuando a un pozo de visita entre una tubería de diámetro y salga otro de 

diferente diámetro, la cota Invert de salida estará situada como mínimo a 

la diferencia de los diámetros de la cota invert de entrada. 

  
BA φφ >  

CInvert de salida = CInvert de entrada – )*)(( 0254.0AB φφ >  

 
c) Cuando en un pozo de visita la tubería de salida es del mismo diámetro 

que las que ingresen a él, la cota Invert de salida estará 3 cm debajo de la 

cota más baja que entre y se tomará el valor menor de los dos resultados. 

 

CBA φφφ ==  

CInvert de salida = CInvert de entrada “A” –0.03 

CInvert de salida = CInvert de entrada “B” –0.03 

 

d) Cuando en un pozo de visita la tubería de salida es de diferente diámetro a 

las que ingresen en él, la cota Invert de salida deberá cumplir  con las 

especificaciones anteriores y se tomará el valor menor, presentando 

diferentes casos: 

 

1.  Ingresa más de una tubería de igual diámetro y sale una de diferente 

diámetro: la cota invert de salida será la diferencia de los diámetros para 

cada una y se toma el valor menor. 
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    B      ;                              φφφφφφ 〉〉= CACBA  

CInvert de salida = CInvert de entrada “A” – )*)(( 0254.0AC φφ −  

CInvert de salida = CInvert de entrada “B” – )*)(( 0254.0BC φφ −  

 

2.  Cuando ingresa más de una tubería de diferente diámetro y sale una de 

diámetro distinto: la cota invert de salida será la diferencia de los 

diámetros para cada una y se tomará el valor menor. 

 
    B      ;                              φφφφφφ 〉〉≠ CACBA  

CInvert de salida = CInvert de entrada “A” – )*)(( 0254.0AC φφ −  

CInvert de salida = CInvert de entrada “B” – )*)(( 0254.0BC φφ −  

 

3.  Cuando ingresa más de una tubería de diferente diámetro, siendo una 

de ellas del diámetro de la tubería de salida: la cota invert de salida será, 

para cada una de ellas, la diferencia de los diámetros, y la otra tendrá 

como mínimo 3 cm. Se tomará el valor menor 

A    C     ; B                          BC    φφφφφφ 〉≠= A  

CInvert de salida = CInvert de entrada “B” – 0.03 

CInvert de salida = CInvert de entrada “A” – )*)(( 0254.0AC φφ −  

 

4.  Cuando sólo una tubería de las que sale es de seguimiento, las demás 

que salgan del pozo de visita deberán ser iniciales. 

 

� La cota invert de salida de la tubería inicial deberá estar como 

mínimo a la profundidad del tránsito liviano o pesado, según se 

considere oportuno. 
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� La cota invert de salida de la tubería de seguimiento deberá cumplir 

con las especificaciones anteriormente descritas. 

 

2.1.11   Características de las conexiones domicili ares 

 

Habitualmente la tubería será de 6 pulgadas, si es de concreto, y 4 

pulgadas, si es de PVC, presentando una pendiente que varía del 2% al 6%, 

que sale de la candela domiciliar hacia la línea principal, uniéndose a esta en un 

ángulo de 45 grados a favor de la corriente del caudal interno  del colector. 

 

En este proyecto se utilizó Tubo PVC. 4" NORMA ASTM F-949 

NOVAFORT así como Silleta "Y" O "T" 6" x 4" NOVAFORT, y para la candela 

se utilizó un tubo de concreto de 12” de diámetro. 

 

 2.1.12   Diseño hidráulico 

 

El diseño de la red de alcantarillado sanitario se elabora de acuerdo con 

las normas ASTM 3034 y  las normas que establece el Instituto de Fomento 

Municipal – INFOM -.  Con el objetivo de hacer más fácil el cálculo  se utilizó un 

programa realizado en una hoja electrónica, para el cual se presenta las bases 

generales de diseño en la siguiente tabla. 
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Tabla  V. Bases generales de diseño del proyecto al cantarillado sanitario 

REFERENCIA                                                                       DESCRIPCION 
Tipo de sistema                                                     Alcantarillado sanitario 
Período de diseño                                  30 años 
Viviendas actuales                  176 viviendas 
Viviendas futuras                                                   494 
Densidad de habitantes                                         6 habitantes/vivienda                                             
Población actual                                                    1056 habitantes 
Tasa de crecimiento                               3.5% 
Población futura                          2964 habitantes 
Dotación                                                                 120 l/hab./día 
Factor de retorno                                                    0.80 
Velocidad de diseño                                               0.40< V ≤4 m/s. (P.V.C.) 
Evacuación                                Por gravedad 
Colector Principal                      
Tipo y diámetro de tubería                    PVC de Ø = 6”     n = 0.010 
Pendiente                                                        Según diseño 
Conexión domiciliar    
Tipo y diámetro de tubería        PVC de 4” 
Pendiente de la tubería                                 2 a 6% 
Candela                                                                    Concreto Ø = 12”   
Pozo de visita    
Altura de cono                                              0.90 m 
Diámetro superior mínimo                         0.75 m 

Diámetro inferior mínimo                                          1.20 m    

Material                                                                     Ladrillo tayuyo 6.5*11*23  cm. 

 

  2.1.12.1   Ejemplo de diseño de un tramo 

 

Se diseñará el tramo comprendido entre el pozo de visita PV-9 y PV-10; 

los datos necesarios para calcularlo son los siguientes: 

 

• Características 

Tipo de sistema                                     Alcantarillado sanitario 

Tramo                                                    De PV-9 a PV-10 (E-5  a  E-6) 

Distancia                                                53.54 m 

        Número de casas del tramo: 1         Casas acumuladas: 46 
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Densidad de vivienda:     6 hab/vivienda      

Total de habitantes a servir:    actuales: 276                            futuros: 775 

• Cotas del terreno                                 Inicial  471.200 m 

                                                                     Final   466.218 m 

• Pendiente del terreno                     ( )
100*

Distancia

CTCT
P

FinalInicial −=  

                                                                  

( )
%9.31      100*

54.53

218.466200.471 =−=P  

• Caudal medio                               .QQQQ infICdommed ++= .  

                                                      86400RFDotaciónHabNoQdom /.**..=                                                           

        / 861.0    86400/80.0*120*775 slQdom ==  

                                                                  

sl25%QdomQC.I / 215.0  861.0*25.0 ===  

                                                       0=infQ  (Tubería PVC) 

                                                       slQmed /  076.1         215.0861.0       =+=   

 

• Factor de caudal medio                       ../ HabNoQfqm med=  

                                                             001388.0775/076.1 ==fqm  

Para este proyecto se tomó el valor de 0.002 como factor de caudal 

medio,   el cual  es  un   dato  regulado  por  el  Instituto  de  Fomento  Municipal   

–INFOM-. 

 

• Factor de Harmond     ( ) ( )2/12/1 4/18 PPFH ++=   y 1000/775=P  

            ( ) ( )2/12/1 775.04/775.018 ++=FH  

                                                       87.3=FH  

• Caudal de diseño                        HFFQMHabNodisq .**..=  

                                                    87.3*002.0*775=disq  
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                                                        sldisq /99.5=  

• Diámetro de tubería                         6”  (Tuvo PVC) 

• Pendiente de tubería                       9.31% 

• Velocidad a sección llena              ( ) 2/13/2 **/03429.0 SDnV =  

                                                          ( ) 2/13/2 )100/31.9(*6*010.0/03429.0=V  

                                                          smV /45.3=  

• Caudal a sección llena               VAQ llena *sec =  

                                                                     ( ) 32
sec 1/1000*45.3*0254.0*6*4/ mlQ llena π=  

                                                       slQ llena /00.63sec =  

• Relación de caudales                     00.63/99.5/ sec =llenadis Qq  

                                                        095.0/ sec =llenadis Qq  

 

• Relación de velocidad                    630.0/ =Vv  

• Relación de tirante                          208.0/ =Dd  

• Velocidad a sección parcial            VvV /*=ν  

                                                                  630.0*45.3=ν = 2.17 m/s  

 

• Revisión de especificaciones hidráulicas: 

a.  Para caudales  qdis < Qsec llena  5.99 l/s  < 63.00 l/s        Cumple 

b. Para velocidad 0.4 ≤ v ≤ 4.00 m/s 0.4 ≤ 2.17 ≤ 4.00 m/s     Cumple 

c. Para diámetros  0.1 ≤ d/D ≤ 0.75 0.1 ≤ 0.208 ≤ 0.75          Cumple 

 

 

• Distancia horizontal efectiva 

Diámetro de pozo:     1.20 m 

Grosor de paredes:    Ladrillo tayuyo 21*12.5*6.5 

                                   DHefec = distancia entre pozos-((Ø1 pv1 + grosor 

                                   paredes pv1)/2 +-(Ø2 pv2 + grosor paredes pv2)/2)   
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                                  mDHefec  88.51)2/)46.020.1(2/)46.020.1((54.53 =+++−=  

• Cota invert de salida del pozo PV-9 (C is) 

                                        =isC  cota invert entrada del pozo 8 – 0.03 

                                         960.46903.0990.469 =−=isC   

• Cota invert de entrada al pozo PV-10 (C ie) 

                                         =ieC cota invert de salida del pozo 9 (Cis) – (9.31%*    

                                          distancia efectiva) 

                                  =ieC 469.960- (0.0931*51.88) = 464.978 

• Profundidad del pozo PV-9 

Alt. PV-9 = cota del terreno – cota invert de salida                       

del pozo PV-9 + 0.15 

Alt. PV-9 = 471.200 – 469.960 + 0.15  = 1.39 m 

• Profundidad del pozo PV-10 

Alt. PV-10 = cota del terreno – cota invert de salida 

del pozo PV-10 + 0.15 

Alt. PV-10 = 466.218 – 464.978 + 0.15  =  1.39 m 

• Volumen de excavación de zanja 

Vol. Exc. = }{( )[ ]ZdHH **2/21+  

Vol. Exc. = }{( )[ ]65.*88.51*2/39.139.1 +    =  42.51 3m  

 

Los datos y resultados del cálculo hidráulico para todos los ramales, realizado 

con el procedimiento anteriormente descrito, se presentan en el anexo 2. 

 

2.1.13   Desfogue 

 

Para todo drenaje sanitario, se debe contemplar la ubicación y el método 

de desfogue hacia un cuerpo de agua o sistema hídrico.  Esto luego de ser 

tratada el agua proveniente del colector, respetando las normas establecidas 

por el Ministerio de Medio Ambiente, para lograr reducir los daños al ambiente. 
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Para ello se debe realizar un estudio y diseño para cada proyecto.  En el 

presente proyecto se utilizará un tratamiento primario de las aguas, para 

proceder a su desfogue al medio ambiente, sin provocar daños significativos al 

descargarlo a la naturaleza. 

 

2.1.14   Propuesta de tratamiento 

 

La mayoría de las aguas negras que provienen de los sistemas de 

alcantarillado se descargan en corrientes naturales.  A pesar de que las aguas 

negras están constituidas, aproximadamente, por 99% de agua y 1% de sólidos, 

su vertido en una corriente cambia las características del agua que las recibe. 

 

El 1% de sólidos es el que impide el crecimiento de plantas acuáticas; los 

de naturaleza orgánica se pudren robando oxígeno al agua con producción de 

malos olores y sabores. 

 

Las materias tóxicas, compuestos metálicos, ácidos y álcalis afectan 

directa e indirectamente la vida acuática; las pequeñas partículas suspendidas 

(como fibras) pueden asfixiar a los peces por obstrucción de sus agallas; los 

aceites y grasas flotan en la  superficie o se adhieren a las plantas e impiden su 

desarrollo. De esto se desprende la necesidad de reducir la descarga de aguas 

negras en las corrientes naturales, a los límites de autopurificación de las aguas 

receptoras. 

 

La autopurificación es el lineamiento principal para determinar los 

procesos de tratamiento, el grado de tratamiento dependerá de un lugar a otro, 

pero existen tres factores que determinan este: 
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a. Las características y la cantidad de sólidos acarreados por las aguas 

negras. 

b. Los objetivos que se propongan en el tratamiento. 

c. La capacidad o aptitud del terreno cuando se dispongan las aguas para 

irrigación o superficialmente, o la capacidad del agua receptora, para 

verificar la auto purificación o dilución necesaria de los sólidos de las aguas 

negras, sin excederse a los objetivos propuestos. 

 

Para el presente proyecto, la recomendación es la construcción de una 

planta de tratamiento primario, pues el objetivo de estas unidades es la 

remoción de sólidos en suspensión, lo que se puede realizar por procesos 

físicos como la sedimentación (asentamiento), en los que se logra eliminar en 

un 40% a un 60% de sólidos, al agregar agentes químicos (coagulación y 

floculación) se eliminan entre un 80% a un 90% del total de los sólidos. Otro 

proceso es la filtración. Las unidades empleadas tratan de disminuir la 

velocidad de las aguas negras para que se sedimenten los sólidos, los 

dispositivos más utilizados son: 

 

• Tanques sépticos o fosas sépticas 

• Tanques Imhoff 

• Tanques de sedimentación simple con eliminación de los lodos  

• Reactores anaeróbicos de flujo ascendente (RAFA). 

 

Para un tratamiento adecuado previo a la disposición de las aguas 

negras, hay que tener en cuenta factores como: espacio disponible para las 

instalaciones, topografía del terreno, costo de la construcción y mantenimiento 

requerido, para seleccionar las unidades adecuadas a la población. 

 



41 
 

En este caso, se propone la construcción de tanques sépticos o fosas 

sépticas con sus respectivos pozos de absorción. Se propone esto porque el 

terreno destinado para el tratamiento, presenta las condiciones adecuadas de 

extensión y ubicación, además de su relativo bajo costo. 

 

Fosas sépticas 

 
 Están diseñadas para retirar  de las aguas servidas los sólidos en 

suspensión orgánicos e inorgánicos sedimentables, mediante el proceso físico 

de la sedimentación. Las fosas sépticas están diseñadas para mantener el flujo 

de aguas negras a una velocidad muy baja y bajo condiciones anaeróbicas 

(falta de oxigeno), por un período de 12 a 24 horas, llamado período de 

retención. 

 

El proceso de sedimentación se logra cuando el líquido está en reposo o 

fluye  a  una  velocidad  sumamente  baja,  durante  el  tiempo  suficiente,  que 

permita  que  se  depositen  en  el  fondo  la  mayor  parte  de  los  sólidos 

sedimentables,  que  son  principalmente  sólidos  orgánicos,  logrando  así  su 

separación de la corriente de aguas servidas. 

 

De los sólidos suspendidos que llegan a la fosa, se decanta la mayor 

parte de la materia sedimentable, la  cual entra en un proceso de digestión 

anaeróbica con disolución, licuación y volatilización de la  materia orgánica, 

previamente a su estabilización. Por esta razón es que la cantidad de lodo que 

se acumula en el estanque es pequeña, pero que con el tiempo constituye una 

cantidad que hace disminuir el volumen efectivo de la fosa y por consiguiente el 

período de retención. 
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Diseño de la fosa séptica 

 
En  la  fosa  séptica,  las materias en suspensión en las aguas negras 

sufren una sedimentación, la materia  orgánica se descompone en sustancias 

más simples por la acción de las bacterias anaeróbicas, que pueden realizar su 

metabolismo sin necesidad de oxígeno. 

 
La  fosa  séptica  es un estanque hermético, que puede construirse de 

ladrillo, piedra, concreto o cualquier otro material que se considere adecuado, 

es un tanque de escurrimiento horizontal y continuo de un solo piso. 

 

Las fosas pueden ser de uno o doble compartimiento.   Investigaciones 

realizadas en fosas con uno y con dos compartimientos, han demostrado que 

las de dos compartimientos proporcionan una mejor eliminación de los sólidos 

en suspensión, lo que constituye un beneficio, pues permite una mayor 

protección del sistema de absorción. 

 
Para el diseño de la fosa séptica debe tomarse en cuenta los siguientes 

parámetros: 

 

� El período de retención es como mínimo de 12 horas 

� Relación largo-ancho de la fosa L/A; de 2/1 a 4/1 

� El lodo acumulado por habitante y por período de limpieza, es de 30 a 

60 l/hab/año. 

 

Nomenclatura y fórmulas 

         ⇒        y       

Donde 

T = Período de retención                            V = Volumen en litros 

Q = Caudal (litro/día)                                  N = Número de personas servidas 
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QG = Gasto de aguas negras Litro/hab/día      q  = Caudal domiciliar (l/s) 

 

Cálculo de volumen 

 

Para el cálculo del volumen se asume una altura (H), que es la altura útil, 

es decir, el fondo de  la fosa al nivel de agua se toma una relación L/A;  dentro 

de los límites recomendados, queda el volumen como: 

 

 

Donde: 

A = Ancho de fosa       L = Largo de la fosa           H = Altura útil. 

 

Se conoce la relación L/A, se sustituye una de las dos en la fórmula de 

volumen y se determina el valor de la otra magnitud. 

 

            Por ejemplo. Si L/A es igual a 2, entonces L = 2A, al sustituir L en la 

fórmula se tiene: 

 

  de donde se obtiene el valor del ancho de la fosa 

 

Cálculo de las fosas para el proyecto 

 

Período de retención  24 horas 

Gasto     120 L/hab/día 

Número de habitantes  1056 hab (176 viviendas) 

Lodos     30 L/hab/año 

Relación largo / ancho  2/1 

Período de limpieza   5 años 
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Volumen para el líquido 

 

Cálculo del caudal 

Q = qdom = 120 L/hab/día x 0.80 x 1056 hab. 

Q = 101,376 L/día 

Q = 101.38 m3/día 

 

Volumen líquido 

Vlíquido = Q*T = 101,376 L/día x 24 horas x 1día/24 horas 

Vlíquido = 101,376 litros 

Vlíquido= 101.38 m3 

 

Volumen de lodos 

 

Vlodo = No. habitantes futuro*(gasto de lodos/1000)*periodo de limpieza 

Vlodo = 1056 hab x 30 l/hab/año 

Vlodo = 31,680 litros (l) 

Vlodo = 31.68 m3 

Vlodo = 31.68 x 5 años (período de limpieza) 

Vlodo = 158.4 m3; para período de limpieza de 5 años 

 
Volumen total: 101,38 m³ + 158.4 m³ = 259.78 m³ 

 

Como L/A = 2 entonces L = 2A al sustituir L en la ecuación 

de V  

Asumiendo H = 3.00 

A² = V/2H 
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Como L = 2A =2(6.58) = 13.16 m 

 

Por lo que las medidas mínimas para que la fosa sea útil son:  

A = 6.58 m  

L = 13.16 m  

H = 3.00 m 

 

Pero aprovechando las dimensiones del terreno, se hace una fosa más 

grande con aboneras y un desarenador que garantice el correcto tratamiento de 

las aguas y el adecuado funcionamiento de la fosa. 

 

Pozos de absorción 

 

Para este proyecto se tomó la decisión de presupuestar un pozo de 

absorción para la fosa séptica, con el fin de darle un tratamiento adecuado a las 

aguas servidas, asegurando así una infiltración de estas a los mantos 

permeables, evitando así la contaminación de los mismos. 

 

2.1.15   Administración, operación y mantenimiento 

 

En este proyecto es necesario formar un comité en la aldea, encargado 

de administrar correctamente las actividades de operación y mantenimiento del 

sistema de alcantarillado, para poder así disminuir los costos de estas 

actividades. Este comité deberá  ser electo anualmente o como la población lo 

estime conveniente, para involucrar a toda la población. 
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A medida que se produce el envejecimiento de los sistemas de 

alcantarillado sanitario, el riesgo de deterioro, obstrucción y derrumbes se 

convierte en una consideración muy importante. Por esta razón todas las 

municipalidades deben hacer esfuerzos para mejorar el nivel de desempeño de 

los sistemas de alcantarillado. La limpieza y la inspección de los colectores de 

agua residual son fundamentales para el mantenimiento y funcionamiento 

correcto del sistema.  Además, extienden la inversión de la comunidad en su 

infraestructura de alcantarillado. 

 

� Técnicas de inspección 

 

Se requieren programas de inspección para determinar la condición 

actual del alcantarillado y  para ayudar a la planificación de una estrategia de 

mantenimiento.  Idealmente las inspecciones del alcantarillado deben realizarse 

en condiciones de bajo caudal, para lo cual pueden efectuarse taponamientos 

temporales del colector para reducir el caudal. La mayoría de los colectores son 

inspeccionados utilizando uno de los métodos siguientes: 

 

• Circuito cerrado de televisión (CCTV) 

• Cámaras 

• Inspección visual 

• Inspección por iluminación con lámparas 

 

Las inspecciones por televisión y cámaras son las usadas con mayor 

frecuencia en los países desarrollados, pues son las más eficientes a largo 

plazo en términos de costos y las más eficaces para documentar la condición 

interna del alcantarillado. 
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Pero para este proyecto, se recomiendan las inspecciones visuales 

debido a su bajo costo.  Es vital para tener un conocimiento completo de la 

condición de los alcantarillados. Las inspecciones visuales de pozos de visita y 

de tuberías incluyen las de superficie y las internas. Los operadores deben 

prestar atención a zonas  colapsadas en el suelo sobre las tuberías y  terreno 

con acumulación de agua.  Las inspecciones deben también examinar en 

detalle la condición física de los cruces de arroyos, las condiciones de los 

brocales y de las tapas de los pozos de visita o de cualquier superficie de 

ladrillo expuesta, y la visibilidad de los pozos y otras estructuras. Para 

colectores grandes se recomienda una inspección interna o una visita a pie 

dentro de la tubería. Esta inspección requiere que el operador entre al pozo de 

visita, el canal y a la tubería, y examine la condición del brocal, la tapa y pared 

del pozo, así como  las paredes de la tubería encima del nivel de flujo. 

 

La inspección de iluminación con lámpara se utiliza para tuberías de 

diámetros pequeños y proyectos cuyos recursos financieros son 

extremadamente limitados. En esta técnica se baja una lámpara dentro del pozo 

de mantenimiento y se coloca en el centro del cruce del brocal del pozo y la 

tubería, verificando así el estado del colector. Este método también es 

recomendable para el presente proyecto por su bajo costo. 

 

� Técnicas de limpieza 

 

Los alcantarillados sanitarios requieren un programa de limpieza para 

mantener su funcionamiento adecuado.  Existen varias técnicas que son usadas 

tradicionalmente para eliminar obstrucciones y como herramientas de 

mantenimiento preventivo. En la siguiente tabla se muestran algunos de los 

métodos de limpieza de alcantarillado sanitario más comunes. 
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Tabla VI. Métodos de limpieza de alcantarillado san itario 

TECNOLOGÍA USOS Y APLICACIONES 

Remoción mecánica  

Método de raspado 

 
• Usa un motor y un eje de soporte con barras de raspado o en sección. 
 
• A medida que rotan las barras estas deshacen los depósitos de grasas, 

cortan las raíces y remueven basura  
 
• Las máquinas de raspado también ayudan a colocar los cables que se usan 

para inspecciones televisadas y las máquinas de baldes. 
 

• Es más efectivo en tuberías hasta de 300 mm (12 pulgadas) de diámetro. 

Máquina de baldes 

 
• Aparato cilíndrico, cerrado en un extremo y con dos mandíbulas opuestas 

de bisagra al otro extremo. 
 
• Las mandíbulas se abren, y raspan los materiales para depositarlos en el 

balde. 
 
• Remueve parcialmente depósitos grandes  de lodo, arena, grava y otros 

tipos de residuos sólidos. 

Remoción hidráulica  

Máquina de esfera 

 
• Una esfera de limpieza de caucho con estrías gira y limpia el interior de la 

tubería a medida que aumenta el flujo en la línea de alcantarillado. 
 
• Remueve depósitos de material inorgánico sedimentado y acumulación de 

grasa. 
 

• Es de mayor eficiencia en tuberías de diámetro desde 13 a 60 cm. (5 a 24 
pulgadas) 

Chorro a presión 

 
• Dirige un chorro de agua de alta velocidad a la tubería desde un pozo de 

visita. 
 
• Remueve la acumulación de basura y grasas, remueve las obstrucciones y 

corta raíces en tuberías de diámetro pequeño. 
 
• Es eficiente para la limpieza rutinaria de tuberías de diámetro pequeño y con 

flujo reducido. 

Carretilla 

 
• Escudo metálico circular con borde de caucho y articulación de bisagra 

montada sobre una carretilla de acero con ruedas pequeñas. El escudo 
funciona como un tapón para inducir una acumulación de agua. 

 
• Restriega la pared interna de la tubería. 
 
• Es eficaz en la eliminación de escombros pesados y la limpieza de grasas 

en la línea. 

Método de vaciado 
 

 
• Introduce un flujo fuerte de agua a la línea desde un pozo de visita. 
 
• Remueve materiales flotantes y en cierta medida arena y grava. 

 
• Es de mayor eficacia cuando se usa en combinación con otras  operaciones 

mecánicas, como por ejemplo limpieza con máquina de baldes. 
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Cometas, bolsas y “poly pigs” 
 

 
• Similar en función a la máquina de esfera 
 
• Los bordes rígidos de la bolsa y la cometa inducen una acción de 

restregado. 
 

• Es eficaz para remover la acumulación de desechos en descomposición y 
las grasas y removilizarlos aguas abajo. 

Fuente: Water Pollution Control Federación, 1989 

 

Si bien todos estos métodos han sido eficaces en el mantenimiento de 

sistemas de alcantarillado, el método ideal para reducir y controlar los 

materiales que se encuentran en las líneas de alcantarillado son los programas 

de educación y prevención de la contaminación. La población debe ser 

informada sobre las substancias comunes de uso doméstico como las grasas y 

aceites, los que deben desecharse en la basura usando recipientes cerrados y 

no a la alcantarilla.  Este método no sólo ayudaría a minimizar problemas de 

plomería a los dueños de viviendas sino que también mantendría  limpios los 

colectores del alcantarillado. 

 

El principal beneficio de realizar un programa de mantenimiento es la 

reducción de los desbordes del alcantarillado, el estancamiento en sótanos, y 

otras descargas de agua residual debidas a la condición subestándar del 

alcantarillado.  

 

2.1.16   Elaboración de planos 

 

Los planos constructivos para el sistema de alcantarillado sanitario se 

presentan en el anexo 4; están conformados por: 

 

- Planta general de la red de alcantarillado sanitario  

- Plantas y perfiles de los distintos tramos  

- Detalle de pozo de visita  
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- Fosa séptica 

 

2.1.17   Elaboración del presupuesto 

 

El presupuesto se elaboró con base en precios unitarios.  El salario de la 

mano de obra tanto calificada como no calificada, se consignó en lo que se 

maneja en la región para casos similares, mientras que los materiales fueron 

cotizados en los distribuidores locales.  

 

Se consideró un porcentaje de indirectos del 30% sobre los precios 

unitarios, el cual se distribuyo en los renglones. 

 

Tabla VII  Presupuesto sistema de alcantarillado sa nitario para aldea Cojol Juyú 

PRESUPUESTO DRENAJE SANITARIO 

No. RENGLON CANTIDAD UNIDAD 
PRECIO 

UNITARIO Total 

1 Preliminares        

1.1 Replanteo topográfico 2513.99 ML Q              7.00   Q         17,597.93  

1.2 Trazo y nivelación 2513.99 ML Q            15.00   Q         37,709.85  

2 Colector general PVC Ø 4" 88.33 ML  Q          272.00  Q         24,025.76 

3 Colector general PVC Ø 6" 2120.55 ML  Q          360.00  Q       763,398.00 

4 Colector general PVC Ø 8" 305.11 ML  Q          450.50   Q       137,452.05  

5 Pozo de visita 60 UNIDAD  Q       6,071.63   Q       364,297.20  

6 Acometidas domiciliares 176 UNIDAD  Q          838.40   Q       147,558.40  

7 Desarenador 1 1  Q     16,288.26   Q         16,288.26  

8 Fosa séptica 1 1  Q   202,500.00   Q       202,500.00  

9 Cajas de registro 3 3  Q          405.00   Q           1,215.00  

10 Pozo de absorción 1 1  Q       6,075.00   Q           6,075.00  

COSTO TOTAL DEL PROYECTO  Q   1,718,117.45  
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2.1.18   Evaluación socioeconómica 

 

En su mayoría este tipo de proyectos no representan un atractivo 

económico, lo cual lleva a plantear un mecanismo para hacerlo viable con 

subsidios, transferencias, impuestos, donaciones, etcétera. Sin embargo es 

indispensable realizar un análisis financiero y determinar la viabilidad del 

mismo. Para ello se utilizarán los métodos del valor presente neto y la tasa 

interna de retorno. 

 

  2.1.18.1 Valor presente neto 

 

Se utiliza para evaluar alternativas mutuamente excluyentes, consiste en 

trasladar todo el flujo de efectivo a un presente y evaluar si se recupera la 

inversión o no, desde el punto de vista rentable. 

 

El valor presente neto negativo del proyecto es de Q 1,718,117.45. Este 

costo será de inversión social por parte de la municipalidad. No se recupera la 

inversión, sino que se beneficia a la población en servicios básicos, por lo cual 

no se estipula  ningún ingreso ni rentabilidad del proyecto. 

 

 2.1.18.2 Tasa interna de retorno 

 

Se conoce como tasa de rendimiento y es el interés donde la persona 

que va a invertir tiene un equilibrio entre el flujo de ingresos y egresos. 

 

Se obtiene la tasa con la cual se reintegran todos los gastos realizados 

durante el proyecto. En este caso la tasa interna de retorno del proyecto es 

negativa, ya que el proyecto no es de utilidad económica y cumple con una 

función social para el desarrollo de la aldea Cojol Juyú. 
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2.1.19   Evaluación de impacto ambiental 

 

  2.1.19.1 Definición de impacto ambiental y evalua ción de  

     impacto    ambiental 

 

Impacto ambiental: es cualquier alteración de las condiciones 

ambientales o creación de un nuevo conjunto de condiciones ambientales 

adverso o benéfico, provocado por la acción humana o fuerzas naturales. 

 

Evaluación de impacto ambiental  (EIA): “Instrumento de política, 

gestión ambiental y toma de decisiones formado por un conjunto de 

procedimientos capaces de garantizar, desde el inicio de la planificación, que se 

efectúe un examen sistemático de los impactos ambientales de un proyecto o 

actividad y sus opciones, así como las medidas de mitigación o protección 

ambiental que sean necesarias para la opción a ser desarrollada.  Los 

resultados deberán ser presentados a los tomadores de decisión para su 

consideración”. 

 

Una evaluación de Impacto Ambiental es hacer un diagnóstico del área 

en donde se realizará o realizó la construcción de un proyecto, determinando en 

detalle la situación ambiental actual del medio biótico y abiótico que será 

impactada directamente por la obra. 

 

La importancia de una evaluación de impacto ambiental radica en 

permitir analizar cada una de las actividades a desarrollar en el proyecto, 

definiendo el área impactada y el efecto o impacto para cada uno de los 

factores ambientales. El estudio de impacto ambiental da a conocer o identifica 

los impactos producidos al ambiente por la obra.   
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Durante la etapa de construcción u operación de la obra es importante 

conocer que el proyecto ocasionará varios impactos negativos de carácter 

transitorio sobre los componentes aire, suelo, agua, biota (hábitat, flora y 

fauna), paisaje, etc. 

 

Localización del proyecto: la aldea Cojol Juyú, se localiza a una 

distancia aproximada de 2 Km. al sur de la cabecera municipal de San Juan 

Comalapa. 

 

Descripción del proyecto: el proyecto consiste en la construcción de 

una red de alcantarillado sanitario para la aldea Cojol Juyú, municipio de San 

Juan Comalapa, departamento de Chimaltenango. 

 

Características generales del proyecto: 

Tipo de sistema:   Alcantarillado sanitario 

Período de diseño:  30 años 

Población actual:  1056 habitantes 

Población futura:  2964 habitantes 

Dotación:   120 l/hab/día 

Factor de retorno:  0.80 

Velocidad de diseño:  0.40<V≤4 m/s 

Evacuación:   Por gravedad 

Costo del proyecto:  Q   1,718,117.45 

Tiempo aproximado de ejecución: 7 meses 

 

Área y situación legal del terreno: el área de influencia del proyecto es 

de aproximadamente 3.5 km2, una parte es montañosa y boscosa; pero también 

hay  áreas de cultivo de milpa y verduras; no se presentan problemas legales 
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debido a que los vecinos son propietarios de los terrenos que serán 

atravesados algunos tramos del sistema. 

 

Los trabajos necesarios para la preparación del ter reno son: la 

limpieza y desmonte del área, la explotación de bancos de material, el manejo y 

disposición final de los desechos sólidos provenientes de la limpieza, desmonte 

y cortes, la excavación y nivelación del terreno, cortes y rellenos de material, 

compactación o consolidación, derrame de lubricantes, combustibles u otro 

material provocado por la maquinaria, etc. 

 

Uso de recursos  naturales del área:  arenas y selectos provenientes de 

bancos de materiales y agua proveniente del sistema de abastecimiento local. 

 

Sustancias o materiales que serán utilizados: diesel y aceites 

lubricantes para la maquinaria de excavación y equipo a utilizar, Tubo PVC Ø 6" 

y 8” con campana y anillo de hule 118 PSI, SDR 35, cemento, piedra, grava, 

arena, y selecto. 

 

  2.1.19.2    Impacto ambiental que será producido:  

 
Datos de la matriz modificada de Leopold ver anexo 3. 
 
Residuos y/o contaminantes que serán generados: dentro de los 

residuos generados se tendrán las emisiones de partículas a la atmósfera, 

descarga de aguas residuales y de lubricantes, entre otros. 

 

Emisiones a la atmósfera:   el componente atmosférico se verá 

impactado por las actividades: a) Operación de maquinaria y equipo, debido a la 

emanación de gases producto de la combustión de derivados del petróleo; 
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 b) explotación de bancos de material; c) acarreo de material; durante la 

realización de estas dos actividades se generarán partículas de polvo, las 

cuales quedan en suspensión. Este impacto puede llegar a producir 

enfermedades respiratorias a los trabajadores y habitantes del área de 

influencia directa. 

 

Descarga de aguas residuales: el manejo inadecuado de excretas, 

provenientes de los campamentos y de otras áreas de trabajo puede generar la 

contaminación del suelo y los cuerpos de agua. 

 

Sitios arqueológicos: es importante como objetivo fundamental para 

este factor determinar si existen vestigios arqueológicos en la zona de influencia 

del proyecto, tratándose de comunidades indígenas con alto interés cultural 

para la sociedad guatemalteca. 

 

Desechos sólidos: dentro de los contaminantes que se producirán en la 

fase de construcción y operación del proyecto se tienen los residuos del 

material de excavación. Además se tendrán desechos producto de la 

maquinaría de excavación como filtros, repuestos usados, neumáticos, 

depósitos de aceite, basura producida por los trabajadores; como también 

cemento, arena, piedra y grava, producto del desperdicio de las construcciones. 

 

Ruidos y/o vibraciones: los impactos ambientales por ruido se dan 

principalmente por la utilización de maquinaria y equipo durante la fase de 

preparación del sitio, explotación de bancos de material y durante la fase de 

construcción del sistema de alcantarillado sanitario. El ruido puede resultar 

perjudicial no sólo para los trabajadores de la empresa contratista, sino también 

para los pobladores de la comunidad. 
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Contaminación visual:  una mala selección del sitio donde se instale el 

campamento, la explotación de bancos de material, o donde se deposite el 

material de desperdicio, pueden ocasionar alteraciones al paisaje, además se 

tendrá actividades propias del proyecto, como la remoción de la cobertura 

vegetal presente a la orilla del tramo y la excavación de zanjas donde se 

instalarán las tuberías.   

 

2.1.19.3   Medidas de mitigación  

 

 Residuos y/o contaminantes que serán generados: la maquinaria y 

equipo utilizados deben tener filtros para reducir la emanación de 

contaminantes.  Durante el transporte de materiales, los mismos deben cubrirse 

con lona para evitar la dispersión de partículas de suelo a lo largo del trayecto 

de acarreo; esto evitará malestar a los pobladores que se encuentran a la orilla 

del tramo en construcción. 

 

Otro aspecto importante que deberá tomarse con especial cuidado es el 

mantenimiento de la carretera  de acceso a la comunidad, con los contenidos 

de humedad adecuados para evitar el polvo; es importante que todo el personal 

que labora en el campo deba equiparse con mascarillas para evitar infecciones 

respiratorias. 

 

 Descarga de aguas residuales: se recomienda que en los 

campamentos se instalen letrinas o en su defecto fosas sépticas, mismas que 

deberán ser ubicadas lejos de los cauces o fuentes de agua, evitando que 

tengan contacto con la capa freática; estas deberán ser en número proporcional 

de 1 servicio por cada 10 personas. 
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 Descarga de lubricantes: es conveniente que para el tratamiento de los 

lubricantes se construya una fosa de captación, para este tipo de residuos en el 

área de campamento; estos posteriormente deberán ser recolectados y 

depositados en toneles de metal para transportarlos a áreas de reciclaje. 

 

Sitios arqueológicos: para este factor deberá realizarse un 

reconocimiento y levantamiento de información detallada para determinar la 

presencia de sitios arqueológicos, o que sean de alto interés cultural o de 

carácter histórico; esta actividad deberá realizarse en conjunto con el Instituto 

de Antropología e Historia —IDAEH-. 

 

 Desechos sólidos: respecto del material de excavación, deberá 

analizarse si puede ser reciclado para una pronta reincorporación, ya que 

disminuirá la explotación de canteras y se evitará la utilización de áreas para su 

disposición. En relación con los repuestos, neumáticos, entre otros, estos 

desechos deberán ser recolectados en el campamento y llevarlos a sitios donde 

puedan ser reciclados o utilizados para alguna labor industrial, pero no deberán 

ser ubicados a lo largo del tramo en construcción, ni en vertederos clandestinos 

y municipales. 

 

 Ruidos y/o vibraciones: la maquinaria, herramienta y equipo a utilizar 

debe encontrarse en adecuadas condiciones de funcionamiento para minimizar 

las emisiones sonoras, además deberá de equiparse a todo el personal de 

campo con el equipo de protección especial. Se recomienda desarrollar los 

trabajos únicamente en jornada diurna. Debe considerarse que este impacto es 

de duración temporal ya que el mismo se presenta durante el tiempo de 

ejecución de la obra. 
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 Contaminación visual: el área de campamento deberá ubicarse de 

preferencia en sitios donde no se afecten las cuencas visuales, o bien donde se 

tengan cortinas vegetales para favorecer el impacto visual. Además, al finalizar 

las labores en el área del proyecto, se deberá adecuar el sitio a las condiciones 

originales, reforestando con especies arbóreas nativas. 

 

La ubicación de los bancos de material será determinante para este 

factor ya que debido a las condiciones topográficas, una mala selección de 

estos sitios afectará el paisaje del lugar, por lo que se recomienda nivelar el 

terreno al finalizar las labores de extracción de material y posteriormente, 

revegetar con especies arbóreas del lugar. 

 

 Áreas protegidas: se deberá evitar la intervención en las áreas 

cercanas al área boscosa principalmente con actividades como: la explotación 

de bancos de material y sitios para él depósito de desperdicio; además, deberá 

evitarse la utilización de dinamita para labores de construcción, ya que podría 

afectar a la fauna existente en el lugar. 

 

Es conveniente que las medidas de mitigación propuestas en el estudio 

sean compatibles con el área en mención, como la reforestación, ya que en el 

caso de la reforestación deberá sembrarse árboles nativos, para no introducir 

especies exóticas en el área. 
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2.2     Diseño de pasarela en la entrada a la cabec era  municipal de San 

 Juan Comalapa  

 

 2.2.1 Descripción del proyecto 

 

La cabecera municipal tiene un problema sobre la seguridad que debe 

prestarse a los peatones en la entrada de San Juan Comalapa: hace falta la 

infraestructura que garantice la seguridad de la población. 

 

El presente proyecto consiste en el diseño de una pasarela para que los 

peatones puedan cruzar la calle sin arriesgar la vida, y hacer fluido el tránsito 

vehicular en la entrada a la cabecera municipal. 

 

Por economía, condiciones del lugar y especificaciones de la oficina 

municipal de planificación se optó por utilizar estructura metálica, además de las 

ventajas que presenta por la rapidez en la instalación. Se proyecta  la 

colocación de fachada para un futuro, así que se considera en el diseño. 

 

 2.2.2 Levantamiento topográfico 

 

Para conocer las distancias y las diferencias de niveles, es necesario 

realizar un levantamiento topográfico de altimetría y de planimetría.  Para ello 

se levantó topografía junto con el equipo de la oficina municipal de planificación, 

dando como resultado el plano de topografía que se encuentra en el anexo 4. 

 

 2.2.3 Estudio de suelos 

  

Se tomó una muestra inalterada del lugar donde se realizará el proyecto, 

a una profundidad de 1 metro (m).  Para determinar el valor soporte del suelo; 
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se efectuó el ensayo de compresión triaxial en el Centro de Investigaciones de 

Ingeniería (CII), Facultad de Ingeniería, Universidad de San Carlos de 

Guatemala. 

 
El método que se aplicó para el cálculo del Valor Soporte fue el del Dr. 

Karl Terzaghi. 

 

Datos obtenidos del Centro de Investigaciones  de I ngeniería, ver anexo 1 

 
 
Tipo de ensayo   No consolidado y no drenado 

Descripción del suelo  Arena limosa, color beige  

Dimensión y tipo de la probeta  2.5” x 5.0” 

Ángulo de fricción interna   Ø = 25.1º (Grados) 

Cohesión     Cu =  8.3 Ton/m2  

 
Datos para hallar el valor soporte 
 
Base  1.00 m 
Peso específico (γs)  1.19 Ton/m3 
Ángulo de fricción interna 25.1 Grados 
Cu  8.3 Ton/m2 
Desplante  1.15 m 
Factor de seguridad F.S. 5 (adimensional) 
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Nq     =  12.86  

 

Factor de flujo de carga última 

Nc = cotφ*(Nq – 1) = cot 25.1*(12.86-1) 

Nc = 25.32 

 

Factor de flujo  

Nγ = 2*(Nq + 1)*Tanφ 

Nγ = 2*(12.86 + 1)*Tan 25.1 

Nγ = 12.98 

 

Capacidad portante última 

qo = 0.4*γs*B*Nγ + 1.3*C*Nc + γs*D*Nq 

qo = 0.4*1.19*1*12.98 + 1.3*8.3*25.32 + 1.19*1.15*12.86 

qo = 296.98 Ton/m2 

 

Capacidad portante neta última 

qon = qo - γs*Dq 

qon = 296.98 – 1.19*2 

qon = 294.60 Ton/m2 

 

Valor soporte  

Vs = qon /F.S.  

Vs = 294.60 / 5 

Vs = 58.92 Ton/m² 

 
Se compara este resultado con los de la tabla VIII para tomar un valor 

adecuado. 
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Tabla VIII. Valor soporte permisible, según el tipo  de suelo 
 
Valor soporte sugeridos para diferentes tipos de suelos 
Material del suelo Ton/m2 Observaciones 
Roca sana no 
intemperizada 645 No hay estructura de grietas 

Roca regular 430   
Roca intermedia 215   
Roca agrietada o porosa 22-86   
Suelos gravosos 107 compactados, buena granulometría 
Suelos gravosos 64 Flojos, mala granulometría 
Suelos gravosos 43 Flojos, con mucha arena 
Suelos arenosos 32-64 Densos 
Arena fina 22-43 Densa 
Suelos arcillosos 53 Duros 
Suelos arcillosos 22 Solidez mediana 
Suelos limosos 32 Densos 
Suelos limosos 16 Densidad mediana 

Fuente: Jadenón Cabrera, Guía teórica para el curso de cimentaciones 1 . 
 

Por seguridad, se decide tomar un valor de diseño de 35 Ton/m2. 

 

 2.2.4 Análisis y diseño estructural 

 

  2.2.4.1 Determinación de cargas 

 

Se utilizará estructura metálica y con el sistema de marcos dúctiles.  Se 

proyecta para un futuro una fachada hecha de tablayeso sobre las vigas 

perimetrales que respetará el diseño arquitectónico que posee la municipalidad.  

La losa será losa-acero con una capa de 3 pulgadas de concreto sobre una 

placa metálica de 3 pulgadas de profundidad.  La altura de la pasarela será de 6 

metros (m) para facilitar el paso de camiones y tráileres. 

 

Las cargas verticales que se considerarán en el análisis estructural serán 

consideradas carga muerta, tales como: el peso propio de la estructura, además 
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de una carga distribuida sobre las vigas de 150 Kg/m por la baranda que 

llevarán sobre ellas, y la futura fachada de tablayeso. 

 
La carga viva que se tomará será de 500 Kg/m² por considerar que 

tendrá alto tráfico.  Además se tomarán las fuerzas sísmicas de acuerdo con lo 

indicado en el código UBC97.   

 

  2.2.4.2 Ubicación de elementos 

 
Para todo ello se utilizará el programa de computación ETABS para el 

diseño de la pasarela.  A continuación, se detalla paso a paso el diseño de la 

misma. 

 
Lo primero que se debe determinar es la distancia de los marcos.  De la 

topografía se tiene información de que la línea central de la pasarela tiene la 

forma mostrada en la figura 4. 

 
Figura 4. Distancia línea central 
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Siendo conservadores en el diseño de pasarelas, se tomó la medida del 

espaciamiento que tendrá a lo largo del trayecto, y se determinó en 1.50 metros 

(m).  Tras esta consideración, la posición de columnas y el espaciamiento de 

marcos quedan como en la figura 5. 

 

Figura 5. Distancia de ejes 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
Con estos datos ya se puede introducir los datos al programa ETABS.   

 
  2.2.4.3 Diseño estructural con ETABS 

 

   2.2.4.3.1 Inicio de modelo 

 

Para iniciar el diseño, lo primero es abrir el programa y hacer Click en 

“OK” en el mensaje que aparece al inicio.  Este mensaje es un Tip que provee 

el programa para un mejor uso del mismo. 
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Figura 6. Primer mensaje de programa 

 

 

Después debe abrirse un nuevo archivo; para hacerlo existen tres 

formas: una es con la combinación del teclado Ctrl+N, o también dando Click al 

icono de la hoja de papel, o entrando al menú File>New Model. 

 

Para todas las funciones del programa existen estos tres métodos para 

poder ejecutar las mismas (icono en la barra de herramientas, combinación de 

teclas, entrando por medio de los menús).  De ahora en adelante, se citará 

únicamente el método por medio de menús, por ser el más fácil de explicar y 

asimilar. 

 

Al entrar a “File>New Model”, aparece la siguiente figura, y se debe dar 

Click en “No”. De esa manera, se inicia el modelo desde cero, definiendo todas 

las propiedades por cuenta personal. 
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Figura 7. Integración de nuevo modelo 

 

 

En la ventana resultante se definirán las líneas guías que ayudarán a 

dibujar la configuración de la estructura.  Lo primero que se hace es cambiar las 

unidades al sistema que se desee utilizar.  Para el caso en estudio, el sistema 

más utilizado es Kilogramo – metro, por lo que se elige Kgf-m. 

 

Del lado derecho donde dice “Story Dimensions” se definen los pisos.  

Para el presente caso es un piso de 6 metros de altura, por lo que en el cuadro 

“Stories” se coloca la cantidad de pisos (en el caso 1), en el cuadro “Tipical 

Story Height” se coloca la altura de los pisos superiores, y en el cuadro “Bottom 

Story Height” se coloca la altura del primer piso (6 m. según el caso 6). 

 

Del lado izquierdo donde aparece “Grid Dimensions”, se establece la 

separación de líneas guías.  Sí fuera una distribución uniforme, se puede utilizar 

el apartado superior “Uniform Grid Spacing”.  Como el caso presente no es ese, 

se debe de seleccionar “Custom Grid Spacing” y dar Click en el botón “Edit 

Grid”. 
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Figura 8. Edición de líneas guías y niveles 

 

 

En la ventana resultante se determinará el espaciamiento y demás 

propiedades de las líneas guías.  Tras verificar que las unidades estén en Kgf-

m, se debe ver en el sector derecho, donde dice “Display grid as” y seleccionar 

“Spacing”.  Si se selecciona “Ordinates” se deberán introducir las distancias 

acumuladas desde el inicio, mientras que con “Spacing” se colocan las 

distancias entre ejes, lo que es más fácil, y por eso se selecciona “Spacing”. 

 

Después, en las tablas a la izquierda se debe modificar la columna 

“Spacing”, introduciendo la distancia entre ejes.  La tabla superior es para los 

ejes en X, y la inferior es para los ejes en Y.  Tras introducir los valores, se da 

Click en “OK”, y nos regresa a la ventana anterior, donde también se la da Click 

en “OK”. 
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Figura 9. Edición líneas guías 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Aparecen dos ventanas, la de la izquierda tiene la vista en planta del 

primer nivel, mientras que la de la derecha es la vista en tres dimensiones. 

 

   2.2.4.3.2 Dibujo de columnas 

 

El siguiente paso consiste en asignar los elementos estructurales.  Se 

puede asignar una sección específica a un elemento, pero también pueden 

asignar una lista de secciones a cada elemento, y el programa determina de la 

lista cual es la sección más económica y adecuada para el elemento.   
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En este caso se utilizarán las listas “A-LatCol” para columnas, “A-LatBm” 

para vigas, pues estas tienen las secciones para columnas y vigas, 

respectivamente, que soportan cargas laterales.  Para las vigas secundarias se 

seleccionará la lista “A-CompBm”, que es que se utiliza para vigas que se 

apoyan sobre otras vigas. 

 

Primero se asignarán las columnas, para ello hay que entrar al menú 

“Draw>Draw Line Objects>Create Columns in Region or at Clicks”.  En la 

ventana que aparece, se debe verificar que en la casilla “Property” aparezca “A-

LatCol”, que será la lista que se utilizará para las columnas. 

 

El puntero se convierte en una flecha negra, y con ella se debe dar Click 

en los puntos donde se quiere columnas orientadas en el eje X, en el presente  

caso B1, C1, B4, C4, D3, D5 y E5. 

 

Después se cambia el ángulo a 90º (grados), y se da Click en los puntos 

donde irán las columnas orientadas en el eje Y. 

 

Figura 10. Propiedades de columna 

 

 

Si se comete un error, se da Click en el ícono de flecha  que cambia 

el modo de introducción al modo selección, y ahora se puede seleccionar el 

elemento que se desee borrar, y para borrarlo se oprime la tecla “Delete” del 

teclado. 
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Algo importante es guardar constantemente el modelo, para evitar 

inconvenientes por algún apagón o similares.  Eso se hace como en cualquier 

otro programa, dando Click en el botón de guardar  . 

 

La primera vez pedirá que se le dé un nombre al proyecto, y una 

ubicación donde se guardará.  Las siguientes veces, sólo lo guardará.  

 

   2.2.4.3.3 Dibujo de vigas 

 

Para asignar las vigas, se debe entrar al menú “Draw>Draw Line 

Objects>Create Lines in Region or at Clicks”.  En la casilla “Property” debe 

aparecer “A-LatBm”.  Con el cursor como flecha negra, se le da Click a las 

líneas donde irá una viga perimetral.  Cada línea que se toque, deberá pintarse 

de color amarillo.   

 

Si se comete una equivocación, se sigue el mismo procedimiento de dar 

Click a la flecha para cambiar el modo a selección, seleccionar el objeto a 

borrar, y después se oprime la tecla “Delete” del teclado. 

 

   2.2.4.3.4 Dibujo de vigas secundarias 

 

Ahora se dibujarán las vigas secundarias a lo largo de la losa.  Se 

colocarán con una distancia de 1.80 metros, pero se adecuarán a cada región la 

cantidad de vigas secundarias que llevará.   

 

Por ejemplo para el vano de 18.36 metros, se deberían colocar 

18.36/1.80 = 10.2 vigas, por lo que se colocarán 10 vigas. 
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Para iniciar, hay que entrar al menú “Draw>Draw Line Objects>Create 

Secondary Beams in Region or at Clicks”.  En la ventana que aparece, hay que 

modificar únicamente la casilla “No. of Beams” colocando cuantas vigas se 

deseen; y la casilla “Approx. Orientation” con la dirección que llevarán las vigas 

(paralelas al eje X o al eje Y). 

 

Figura 11. Propiedades de vigas secundarias 

 

 

Con la adición de los elementos, la planta de la estructura se ve como la 

figura 12.  
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Figura 12. Vista planta  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   2.2.4.3.5 Dibujo de losas 

 

Para el dibujo de las losas se debe abrir el menú “Draw>Draw Area 

Objects>Draw Areas”.  Se verifica que la ventana que aparece, en la casilla 

“Property” diga “Deck 1” y se procede a dibujar la losa.   

 

Para ello se deben tocar los puntos perimetrales donde irá la losa, y 

después de tocar el primer punto desde donde se partió, se oprime la tecla 
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“Enter” para finalizar.  En este caso se dibujarán cuatro losas, dos para las que 

tienen las vigas secundarias perpendiculares en sentido del eje X y otras dos 

para las que las tienen en sentido del eje Y. 

 

Aparece una doble flecha con la dirección de la losa.  Esta debe de ir 

perpendicular a las vigas secundarias.  Como las losas que tienen vigas en el 

eje X tienen la flecha paralela a sus vigas secundarias, se le debe cambiar el 

eje a las losas. Por lo que se seleccionan ambas, dando un Click a la doble 

flecha.  Se dibuja una línea punteada a lo largo de toda la losa. 

 

Después se va al menú “Assign>Shell/Area>Local Axes” y aparece un 

cuadro como el de la figura 13, donde se debe cambiar “Angle” a 90º (Grados).  

Cabe resaltar que si no se tienen seleccionadas las losas, estas opciones no 

estarán habilitadas. 

 

Figura 13. Eje local 

 

 

Si se comete un error, se debe cambiar al modo selección (haciendo 

Click al botón flecha ) e ir al menú “Edit>Undo Area Object Add”.  
 

Para definir las propiedades de la losa, hay que entrar al menú 

“Define>Wall/Slab/Deck Sections” con “Deck 1” resaltado, se le da Click al 
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botón “Modify/Show Section”.  En la ventana que aparece, lo único que se debe 

cambiar es la casilla “Slab Depth” a 3, pues el relleno de concreto sobre la losa 

será de 3 pulgadas. Después se da Click en “OK”, para regresar al cuadro 

anterior, y se le da “OK” nuevamente. 

 

Figura 14. Propiedades de losa 
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   2.2.4.3.6 Apoyos 

 

El programa coloca apoyos articulados a las columnas.  Sin embargo en 

el presente caso se necesita de apoyos empotrados, por lo que, para 

modificarlos, lo primero que debe hacerse es cambiar la vista, para que en lugar 

del nivel 1, muestre la base. 

 

Para ello, hay que entra al menú “View>Set Plan View”, y en la ventana 

elegir “Base” y dar Click en “OK”.  Aparecerá la planta de la base. 

 

Figura 15. Establecer vista de planta 

 

 

Se selecciona cada apoyo dando un Click sobre él.  Aparece una equis 

punteada sobre el apoyo, indicando que está seleccionado.  Cuando ya todos 

están seleccionados, se entra al menú “Assign>Joint/Point>Restraints 

(Supports)”.  En la ventana que aparece, se la da Click a la figura del apoyo 

empotrado; de manera que al hacerlo, todas las casillas superiores se 

seleccionen.  Luego se le da Click en “OK”. 
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Figura 16. Apoyos 

 

 

Para volver a ver la planta del nivel 1, se repite el mismo proceso, 

eligiendo “Story 1” en la figura 15. 

 

   2.2.4.3.7 Determinación de cargas 

 

Las cargas que se determinarán son: 

 

• La carga muerta del peso propio de la estructura, 

• La carga muerta del tablayeso sobre las vigas (proyectado a futuro) 

• La carga viva, que por ser marcos de acero puede ser reducida 

• La carga de sismo, de acuerdo con el  código UBC97 

 

Se va al menú “Define>Static Load Cases”.  En la ventana que se abre, 

aparecen las cargas Muerta y Viva.  La carga muerta está bien como 

aparece en la ventana, con el valor “Self Weight Multiplier” en 1.  Esto 

significa que esta carga incluirá el peso propio de la estructura.  Todas 



77 
 

las demás cargas deben tener este valor en cero (0), para evitar que el 

peso de la estructura se considere dos veces durante el análisis. 

 

La carga viva sí hay que modificarla, por lo que se le da un Click, y en la 

línea superior se cambia en la columna “Type” se selecciona del menú 

desplegable “Reduce Live”, y después se da Click en el botón “Modify Load”. 

 

Para agregar una carga adicional de tablayeso (material proyectado a 

futuro para usar como fachada) a la baranda, se va a la línea superior, y en la 

casilla “Load” se escribe el nombre de la carga, para el presente caso 

“TABLAY”, y en el cuadro “Type” se elige “Super Dead”.  Luego se le da Click al 

botón “Add New Load”.   

 

El mismo proceso se hace para incluir la carga de Sismo, con el nombre 

“SY”, con el tipo “Quake”, y en “Auto Lateral Load” se elige UBC97.  Después 

de dar Click en “Add New Load”, se hace lo mismo en “Modify Lateral Load” y 

aparece una ventana con todos los parámetros del código UBC figura 17. 
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Figura 17. UBC 97 

 

 

Para el presente caso, se cambia en la esquina superior izquierda por “Y 

Dir+Eccen X”, para que se vincule la carga que actúa en dirección del eje Y con 

excentricidad positiva en eje X.  Cuando están todos los valores, se da Click en 

“OK”. 

Se hace lo mismo con la carga de sismo en el eje X, eligiendo “X 

Dir+Eccen Y”.  Al final la ventana de cargas se debe ver como la figura 18, y se 

da Click en “OK” para terminar la definición de cargas.  
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Figura 18. Definición de cargas 

 

 

   2.2.4.3.8 Asignación de cargas 

 

Las cargas muertas y de sismo son analizadas por el programa, 

determinando donde actúan y con qué magnitud.  Las cargas vivas y por 

tablayeso, deben ser introducidas manualmente. 

 

Para la carga viva, se debe seleccionar las losas dando un Click en 

cualquier parte dentro de la losa, excepto las vigas.  Una línea punteada 

alrededor del perímetro de la losa indicará que está seleccionada. 

 

Después se va al menú “Assign>Shell/Area Loads>Uniform”.  En la 

ventana que aparece, se debe cambiar las unidades a Kgf-m, y en la casilla 

“Load” se introduce el valor, que en el presente caso corresponde a 500 Kg/m².  

La casilla “Direction” indica si va en dirección donde actúa la fuerza, que es en 

sentido de la gravedad, por lo que se deja “Gravity” en la casilla. Luego se da 

Click en “OK”. 
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Figura 19. Asignación carga viva 

 

 

Ahora para la asignación de la carga de tablayeso a las vigas 

perimetrales, se facilita la asignación si no está activado el “Snap”, es decir que 

automáticamente elige los puntos más cercanos. 

 

Para desactivarlo, se debe ir al menú “Draw>Snap to>Grid Intersections 

and Points”.  Aparece el botón presionado, por lo que al darle Click se desactiva 

la opción. 

 

Ahora se seleccionan todas las vigas perimetrales que llevarán encima la 

fachada de tablayeso.  Si se comete un error, se le da Click al botón , lo que 

elimina todas las selecciones, y se inicia nuevamente. 

 

Cuando todas están seleccionadas, es decir, que se han convertido en 

líneas punteadas, hay que ir al menú “Assign>Frame/Line Loads>Distributed”.  

En la ventana que parece, se verifica que las unidades sean  Kgf-m, se cambia 

el cuadro “Load Case Name”, y se selecciona “Tablay”.  En la parte inferior, en 

la casilla “Uniform Load”, se coloca el valor 150 Kg/m, que es la carga uniforme 
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que se le asignó a la estructura de la baranda.  Se da Click en “OK” para 

finalizar de asignar la carga, figura 20. 

 

Figura 20. Asignación carga distribuida 

 

 

   2.2.4.3.9 Análisis 

 

Ahora que ya se han colocado todos los elementos estructurales, y 

asignadas las cargas, se procede a darle la orden al programa que realice el 

análisis.  Para ello, debe irse al menú “Analyze>Run Analysis”, y en la ventana 

que aparece dar Click en “Run”, figura 21.  

 

 

 

 

 



82 
 

Figura 21. Correr análisis  

 

 

Aparecerá en la ventana de la derecha, el diseño deformado de la 

estructura.  En la parte inferior derecha hay un botón “Start Animation” figura 22, 

que al darle Click inicia la animación del comportamiento de la estructura ante 

las distintas cargas.  Para cambiar la carga se le da Click en las flechas que 

están a un lado.  La carga que se muestra, aparece en el titulo de la ventana. 

 

Figura 22. Botones animación 

 

 

   2.2.4.3.10 Diseño de vigas secundarias 

 

Primero se verifica que las vigas sean diseñadas como vigas 

secundarias, y para ello, en la ventana izquierda, se le da Click derecho a una 

viga secundaria.  Aparece una ventana como la que aparece en la figura 23. 
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Figura 23. Información vigas secundarias  

 

 

En la casilla “Design Procedure” debe aparecer “Composite Beam”.  Esto 

indica que los datos ingresados han sido correctos, pues de lo contrario 

aparecería “Steel Frame”, y se diseñaría de manera distinta.  Se da Click en 

“OK” para cerrar la ventana. 

 

Ahora, hay que entrar en el menú “Options>Preferences>Composite 

Beam Design” figura 24.  Verificar en la ventana que aparece, que en la casilla 

“Design Code” aparezca “AISC-LRFD93”, que será el código que se utilizará 

para las vigas secundarias. 
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Figura 24. Preferencias de diseño 

 

 

Ahora se da Click en la ventana derecha, la que tiene la imagen en 3D, y 

luego se entra al menú “View>Set Building View Options” figura 25.  En la 

ventana que aparece se debe ver que no estén seleccionados “Object Fill” del 

campo  “Special Effects” y “All Null Areas” de “Object Present in View”.  Luego 

se selecciona “Apply to All Windows” que aparece en la parte inferior izquierda, 

y se da Click en “OK”. 
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Figura 25. Opciones de vista 

 

 
Ahora con la ventana a de la vista 3D seleccionada, se entra al menú 

“Desing>Composite Beam Design>Start Design Without Similarity” figura 26.  El 

programa realiza el diseño y muestra las secciones que en el mismo se 

determinó usar. 
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Figura 26. Vista de diseño de vigas secundarias 

 

 

Ahora se debe ir al menú “Design>Composite Beam Desing> Verify 

Analysis vs Design Secctions”.  A la ventana que aparece, se le da Click en 

“No” figura 27. 
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Figura 27. Mensaje diseño vigas 

secundarias

 

 

Este mensaje es porque el programa realizó el análisis con el peso 

promedio de la lista de vigas, pero a la hora de realizar el diseño, algunas 

variaron de sección.  En este caso particular fueron 38 vigas. Por lo que se 

debe repetir el análisis, para que el programa ahora use estas nuevas 

secciones, y realizar nuevamente el proceso hasta que las secciones de diseño 

y las de análisis sean las mismas. 

 

Los pasos a seguir ahora son: 

1. “Analyze>Run Analysis”, y dar Click en “Run”, 

2. “Design>Composite Beam Design>Start Design Without Similarity”, 

3. “Design>Composite Beam Desing> Verify Analysis vs Design Secctions”. 

 

Se repite el proceso hasta que aparezca un mensaje como el de la figura 

28. 

 

Figura 28. Mensaje final diseño vigas secundarias  
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Ahora se debe ir al menú “Design>Composite Beam Design>Verify All 

Members Passed”.  El mensaje de la figura 29, indica que todos los miembros 

han pasado los chequeos de diseño.  Se da Click en “OK”. 

 

El siguiente paso es seleccionar todos los elementos mediante la 

combinación del teclado Ctrl+A e ir al menú “Design>Composite Beam 

Design>Make Auto Select Section Null”, y se le da Click “OK” al mensaje que 

aparece.   

 

Figura 29. Información diseño vigas secundarias  

 

 

Se da Click en el botón  para desactivar las selecciones activas.  

Luego puede hacerse un acercamiento para observar las secciones que 

terminaron por quedar asignadas a cada viga figura 30. 
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Figura 30. Vista vigas secundarias  

 

 

Para quitar el texto de las secciones, ir al menú “Asign>Clear Display of 

Asigns”. 
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   2.2.4.3.11 Diseño de marcos de acero 

 

Lo primero es revisar que las vigas y columnas vayan a ser diseñadas 

como marcos de acero, para ello, en la vista de la planta (ventana izquierda) se 

le da Click derecho a una viga.  

 

Figura 31. Propiedades viga  

 

 

En la casilla “Design Procedure” debe decir “Steel Frame”, para que el 

diseño sea el correcto.  Luego se da Click en “OK” figura 31. 
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Ahora se debe dar Click en la ventana derecha (vista 3D), y después entrar 

en el menú “Design>Steel Frame Design>Start Design/Check of Sructure”.  Al 

igual que en el diseño de las vigas secundarias, aparece un mensaje donde 

indica que 38 elementos difieren del diseño y el análisis, figura 32. 

 

Figura 32. Mensaje diseño  

 

 

Se da Click en “No”, y ahora se elige la ventana izquierda, e ir al menú 

“Design>Steel Frame Design>Display Design Info”.  En la ventana que aparece, 

debe estar seleccionado “Design Output” y seleccionada la opción “PM Ratio 

Colors & Values”, se da Click en “OK”, figura 33. 

 

Figura 33. Formato de despliegue  

  

 
En pantalla aparece información del diseño de las vigas, y al darle Click 

derecho a cualquier viga, aparece una ventana con la información completa, 

figura 34. 
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Figura 34. Información diseño de vigas  

 

 

Si se le da Click a “Details” aparece una versión imprimible del reporte 

figura 35.  Para salir de este reporte se cierra la ventana, y para salir de la 

ventana anterior, se da Click en “Cancel”. 
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Figura 35. Reporte diseño viga 

 

Puede verse en la parte superior derecha de la figura 35, que las 

secciones de diseño y análisis son distintas;  por lo que se repite este último, 

hasta que no exista diferencia. 

 
Para ello los pasos a seguir son: 

1. “Analyze>Run Analysis”, y dar Click en “Run” 

2. “Design>Steel Frame Design>Start Design/Check of Structure” 

 
Al finalizar aparecerá una ventana con la cantidad de elementos que 

difieren su sección del análisis con el diseño.  Se da Click en “No”, y se repiten 

estos pasos hasta que no aparezca el mensaje. 

  
 Cuando eso sucede, se seleccionan todos los elementos mediante la 

combinación del teclado Ctrl+A.  Luego, ingresar al menú “Design>Steel Frame 

Design>Make Auto Select Section Null”, y se da Click “Aceptar” en el mensaje 

resultante figura 36. 



94 
 

Figura 36. Mensaje ETABS  

 

 

El siguiente paso es ingresar al menú “Design>Steel Frame 

Design>Verify All Members Passed”, y deberá aparecer un mensaje como el de 

la figura 37, indicando que todos los miembros han cumplido los chequeos de 

diseño.  Dar Click en “Aceptar”. 

 

Figura 37. Chequeo diseño  

 

 

Con esto, ha finalizado el diseño.  Para poder ver mejor las secciones 

resultantes, se le da Click en el botón  para des-seleccionar los elementos, y 

ya se pueden leer las secciones para cada elemento, figura 38. 
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Figura 38. Vista 

secciones

 

 

Las secciones resultantes se presentan en los planos constructivos en el 

anexo 4. 
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Diseño de las columnas de la pasarela (memoria de c álculo simplificada) 

 
En el diseño de la pasarela existen varios tipos de columnas, desde 

columnas de acero hasta las de concreto armado; a continuación se detalla el 

diseño de cada una de estas.  

 
Diseño de columna C-1 de acero 

 
Detalle de columnas ) 

 

 
 
  

 

 

 

 

 

 

 

 

 

 

 

 

Se propone usar para la columna con una sección W12X190  

Ry= 8.26 cm   A= 24.64 cm² 

Donde: 

Ry = radio crítico de giro respecto del eje Y   k = Factor de longitud 

A = área de la sección      L = Longitud del miembro 
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              Esfuerzo admisible             
 

 
 
 El “Pa” es la carga axial permisible que resiste la sección de acero 

W12x190, ahora calcularemos la carga que llega a la columna. 

 

 Para calcular la carga que le llega a la columna, se toma en cuenta la 

carga total que le llega a la viga (en la carga total va incluida la carga viva y la 

carga muerta, que es el peso propio de la estructura), la carga que se le 

transmitirá  a la columna son las reacciones en  cada uno de los apoyos de la 

estructura y se  obtiene del análisis estructural realizado por ETBAS. 

 
Diagrama de carga distribuida (W) 
 
 
 
              Ra                                              L=17.11 m                                                     Rb 
 
Cálculo de reacciones Rb y Ra en los apoyos, ecuaci ón de momentos en a 
igual a cero (0).  
 

 
 
 
Diagrama fuerza cortante (V) 

 
 
20566.22 kg 

V 
      20566.22 kg 

W=2404 kg/m 
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La sección propuesta de acero W12X190 resiste perfectamente la carga 

que le llega a la columna. Además se colocarán miembros sección U en 

diagonal, para restringir el movimiento lateral de la columna. (ver anexo en 

planos constructivos). 

 
 A continuación se diseñará la columna C-1, que soporta la columna de 

acero; la misma, es de concreto reforzado. 

 
Datos: 

b = 0.40 m (base) 

h =  0.40 m (ancho) 

 
 La carga que se transmite es el peso propio de la columna de acero y la 

carga que le es transmitida a la misma. 

 

Peso propio   

Carga total   

Momento   

 

Ahora para calcular el refuerzo se tomará del diagrama de interacción  

                         
 

Factor balanceado           

 
Área de acero           

Donde: 

P = Carga que actúa en la columna 

e = Excentricidad de la carga P 

Ag = Área gruesa de la sección 
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h = Ancho de la sección  

ρ = Cuantía de acero  

As = Área de acero requerida  

 
 Se colocarán 6 refuerzos No.6 (3/4”) que proporcionan un área de acero 

de 17.10 cm² 

 Para las columnas C-2 y C-3 se diseñarán con un , ya que la 

carga que les llega a estas es menor a la C-1. 

 
 

 
Se colocarán 4 refuerzos No.4 (1/2”) que proporcionan un área de acero 

de  5.07 cm² 

 
 Y para la columna C-4 se tomará un  

 
 

 
Se colocarán 4 refuerzos No.3 (3/8”) que proporcionan un área de acero 

de  2.85  cm². (Ver detalle de todas las columnas en anexo de los planos 

constructivos). 

 
Diseño de  cimentación 

 
Diseño de la zapata cuadrada: Z-1 

 
b columna  40.00 cm  (base) 

f'c  210.00 kg/cm² (esfuerzo del concreto) 

fy  2800.00 kg/cm² (esfuerzo del acero) 

CM  7019.66 kg   (carga muerta) 

CV  7550.00 kg  (carga viva) 

 Carga total        22016.52 kg  (carga mayorada). 
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Datos obtenidos en laboratorio y pre-dimensionamiento: 

Ángulo de fricción interno  Φ: 25.1º 

Peso específico suelo  γh: 1.41 gr/cm3  (0.0014 kg/cm3) 

Profundidad cimentación,  D: 1.00 m 

Cohesión C: 0.83 kg/cm2 

Factor de seguridad F: 4 adimensional 

Ancho cimentación B: 1.25 m 

 
 
Carga admisible: 

 

 

  = 6.25 kg/cm² 

D = 1.00 m 

 
Área requerida:  

 

 Base                               

 
 Al calcular la base, el resultado es de 48.28 cm.; debido a la alta 

resistencia del suelo, la base de la zapata resulta pequeña, por criterio en los 

mismos, se aumentará a: 

 
 
Peralte a utilizar: 

 

Presión de apoyo: 
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Peralte necesario para corte por punzonamiento: 

 

 

 

  

 

Peralte necesario por corte directo: 

 

 

 

 

Cálculo del área de acero de la zapata: 

 

 

 

 

 

 Se colocará el área de acero mínimo de 3.93 cm². El área de acero que 

cubre lo requerido es de 6 varillas No. 3 (3/8”) que constituirá un área de 4.28 

cm² en ambos sentidos. 
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Diseño de la zapata cuadrada: Z-2 

 

b columna  30.00 cm  (base) 

f'c  210.00 kg/cm² (esfuerzo del concreto) 

fy  2800.00 kg/cm² (esfuerzo del acero) 

CM  3509.83 kg   (carga muerta) 

CV  3775.00 kg  (carga viva) 

 Carga total        10251.80 kg  (carga mayorada). 

 
  = 6.25 kg/cm² 

D = 1.00 m 

 
Área requerida:  

 

 Base                           

 
 Al calcular la base, el resultado es de 34.14 cm.; debido a la alta 

resistencia del suelo, la base de la zapata resulta pequeña, por criterio en los 

mismos, se aumentará a: 

   

 
El peralte a utilizar es de: 

 

 
Presión de apoyo: 
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Peralte necesario para corte por punzonamiento: 

 

 

 

  

 

Peralte necesario por corte directo: 

 

 

 

 

Cálculo del área de acero de la zapata: 

 

 

 

 

 

 Se colocará el área de acero mínimo de 3.93 cm². El área de acero que 

cubre lo requerido es de 5 varillas No. 3 (3/8”), que proporcionan un área de 

3.56 cm², en ambos sentidos. 
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Diseño del cimiento corrido 

 
t cimiento corrido            20.00  cm  (espesor muro o elemento) 

CM   3509.83 kg  (carga muerta)  

CV   3775.00 kg  (carga viva) 

Carga total   10251.80 kg   (carga mayorada) 

qu            49500.00 kg/m² (soporte ultimo) 

Df         0.60 m  (profundidad) 

f'c     210.00 kg/m²  (esfuerzo del concreto) 

fy    2800.00 kg/m² (esfuerzo acero) 

 γs       1410.00  kg/m³  

 
 La carga muerta y la carga viva constituyen el peso del muro, lo que le 

trasmite la losa al muro de ambos niveles. 

 
 

 

 

 

 
La base que se utilizará será de 40 cm. por factor de seguridad. 
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 Para calcular el área de acero que requiere el cimiento corrido se utiliza 

el siguiente gráfico; para utilizar el mismo, las unidades de las variables deben 

estar en el sistema inglés de medidas libras-pulgada (lb-plg); se necesita la 

relación Mu/Φbd² donde se toma una base unitaria de 100 cm, y se usa la curva 

60/4, al utilizar concreto de 3000 PSI (210.00 kg/m² ) y acero con resistencia 

40000 PSI (2800.00 kg/m²) 

 
Momento último (Mu) 233.54 kg-m equivale a  20227.87 lb-plg 

Base       (b)   100 cm          equivale a    39.37 plg 

Peralte       (d)   13 cm            equivale a    5.12 plg 

 
Capacidad de momento de secciones rectangulares 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

Fuente: Diseño de estructuras de concreto, Arthur Nilson 
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Se colocarán varillas No. 3 (3/8”) @ 0.20 m las cuales proporcionan un 

área de acero de 3.56 cm², (ver planos constructivos en anexos). 

Para el área de acero longitudinal se colocará el área de acero mínimo.  

 

 

Se utilizarán 3 varillas No.3 (3/8”) las cuales proporcionan un área de 

acero de 2.14 cm², (ver anexo,  planos constructivos). 

Diseño de platinas 

 
 Para garantizar que las cargas de las columnas se transmitan 

uniformemente sobre sus placas de base, es esencial que exista buen contacto 

entre los dos elementos. Para lograr esto es necesario enderezar las placas de 

espesor mayor de 2 pulgadas y hasta 4 pulgadas por medio de prensado o 

fresado. 

 
Datos: 

 
Columna =  

Carga  =  
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Determinar área de la placa: 

 

 

 

Dimensiones de la placa: 

 

 

 

 

 

Presión en la columna de concreto C-1: 

 

 

Cálculo de las dimensiones m y n: 

 

 

 

 

Determinación de L 

 

 Como la placa no cubre todo el concreto: 
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Cálculo del espesor de la placa:  

 

 

 

Las dimensiones resultantes del análisis son placas PL 3/2” X 3.54” X 13.25”   

pero las que se utilizarán son las de  dimensiones mínimas de la columna  

3/2” x 12” x 12” 

 

Para la platina de las columnas C-2 y C-3 el cálculo es el mismo, el resultado 

obtenido es ¾” x 8” x 8” y  ½”x12”x12”,  respectivamente. 

 

Diseño de pernos  

 Pretensión mínima de pernos 

Pretensión mínima de pernos 
Tamaño 
perno 

(pulgadas) 

Pernos 
A325 

Pernos 
A490 

1/2 12 15 
5/8 19 24 
3/4 28 35 
7/8 39 49 
1 51 64 

1 1/8 56 80 
1 ¼ 71 102 
1 3/8 85 121 
1 1/2 103 148 

                                           Fuente: Especificaciones AISC 2005 

Para encontrar el número de conectores N1 de cortante se usa la 

siguiente ecuación.  
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Donde: 

Vh = Valor mínimo de la fuerza cortante horizontal. 

q = Capacidad de cortante del perno tomado de la tabla. 

As = Área sección transversal. 

fy = Resistencia. 

 

 

 

Se usarán pernos de 7/8” con capacidad de 39 kips, el número requerido 

es de: 

 

 

En la columna C-1 se utilizarán 4 pernos y 2 en la columna C-2; luego, 4 pernos 

de ½” en columna C-3 (ver planos constructivos). 
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 2.2.5 Mantenimiento de la estructura metálica 

 
Cada año: inspección visual de fisuras en elementos estructurales, así 

como de humedades que puedan deteriorar la estructura metálica. 

 

POR EL PROFESIONAL CALIFICADO 

 

Cada año: protección de la estructura metálica con pintura anticorrosiva a 

dos manos. 

 

Cada tres años: protección de la estructura metálica con pintura 

anticorrosiva. Reparación o reemplazo de elementos estructurales si fuera 

necesario. Para volver a pintar el elemento estructural, bastará con limpiar las 

manchas si el recubrimiento está en buen estado. En el caso de existir otro tipo 

de defecto, como paso previo a la pintura, se eliminarán las partes sueltas con 

cepillo de alambre y se limpiará para luego pintar. 

 

 2.2.6 Elaboración de planos 

 

Los planos que servirán para la construcción de la pasarela se presentan 

en el anexo 4.  Incluyen la planta de conjunto, como las vistas laterales, y los 

detalles estructurales. 

 

 2.2.7 Elaboración de presupuesto 

 

Se cotizaron los perfiles estructurales, así como los demás materiales 

que se utilizarán para la construcción de la pasarela; los precios se muestran en 

la tabla IX. 
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Tabla IX. Presupuesto pasarela entrada a cabecera m unicipal  

PRESUPUESTO PASARELA 

No. RENGLÓN 

 
 

CANTIDAD UNIDAD PRECIO 
UNITARIO TOTAL 

  

1 PRELIMINARES         

1.1 

MODIFICACIONES DEL TENDIDO ELÉCTRICO Y 
TELEFÓNICO (MOVIMIENTO DE POSTES Y SUBIR 
ALTURA DE CABLES) 1.00 GLOBAL Q876.25 Q876.25 

1.2 TRAZO Y ESTAQUEADO 72.00 ML Q25.45 Q1,832.40 

2 CIMENTACION         

2.1 EXCAVACIÓN ESTRUCTURAL 45.00 M3 Q228.00 Q10,260.00 

2.2 
REACONDICIONAMIENTO DE TUBERÍAS 
EXISTENTES 1.00 GLOBAL Q3,984.00 Q3,984.00 

2.3 RELLENO Y COMPACTACIÓN 32.00 M3 Q140.00 Q4,480.00 

2.4 ZAPATA Z-1 DE 0.30 X 1.25 X 1.25 M 16.00 UNIDAD Q1,500.00 Q24,000.00 

2.5 TRONCO DE COLUMNA TIPO C-1 DE 0.40 X 0.40 M 44.00 ML Q400.00 Q17,600.00 

2.6 ZAPATA Z-2 DE 0.30 X 0.70 X 0.70 M 10.00 UNIDAD Q1,050.00 Q10,500.00 

2.7 TRONCO DE COLUMNA C-2 DE 0.30 X 0.30 M 15.20 ML Q400.00 Q6,080.00 

2.8 GRADAS FUNDIDAS 1.00 MÓDULOS Q6,500.00 Q6,500.00 

3 ESTRUCTURA         

3.1  ESTRUCTURA DEL PUENTE   96.00 M2 Q1,260.00 Q120,960.00 

3.2 LOSA DEL PUENTE 96.00 M2 Q300.00 Q28,800.00 

3.3 ESTRUCTURA DE TORRES PARA PUENTE 4.00 UNIDAD Q65,000.00 Q260,000.00 

3.4 ESTRUCTURA DE TORRES PARA DESCANSOS 2.00 UNIDAD Q25,390.00 Q50,780.00 

3.5 LOSA DE DESCANSOS 6.00 M2 Q375.00 Q2,250.00 

3.6 ESTRUCTURA Y FUNDICIÓN DE GRADAS 19.00 M2 Q1,000.00 Q19,000.00 

3.7 BARANDA DE GRADAS 33.00 M2 Q217.00 Q7,161.00 

3.8 BARANDA DE PUENTE 180.00 M2 Q258.00 Q46,440.00 

3.9 PINTURA 1.00 GLOBAL Q19,251.35 Q19,251.35 

COSTO TOTAL DEL PROYECTO Q640,755.00 
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CONCLUSIONES 
 
 
 

1. Para contribuir con el mejoramiento de la calidad de vida y una salud 

integral, es importante el manejo adecuado de las aguas residuales. El 

sistema de drenaje sanitario dará un tratamiento primario a las aguas 

residuales por medio de fosa séptica,  para luego desfogarlas al pozo de 

absorción como cuerpo receptor. De esta manera se dará un manejo 

íntegro de las aguas residuales de la aldea Cojol Juyú. 

 

2.  El proyecto de drenaje sanitario de la aldea Cojol Juyú consta de  

2,513.99 metros de tubería de PVC para drenaje sanitario con diámetros 

que van desde los 4 a 8 pulgadas; según el diseño en cada ramal, se 

ubican 60 pozos de visita para verificar el buen funcionamiento del 

colector dentro del sistema y se harán 176 conexiones domiciliares 

correspondientes a las familias beneficiadas. 

 

3. Se proponen diversos métodos que, con base en la experiencia,  han 

sido eficaces en el mantenimiento de sistemas de drenaje sanitario o 

alcantarillado; pero el método ideal para reducir y controlar los materiales 

que se encuentran en las líneas de alcantarillado, son los programas de 

educación y prevención de la contaminación. 

 

4. Durante el diseño del sistema de drenaje sanitario se tomaron en cuenta 

los parámetros que indican las normativas respectivas, pero también, la 

aplicación del criterio que como ingeniero se va obteniendo. Se obtuvo 

una tasa de retorno negativa, pues el beneficio costo es de Q 1,627.00 

por cada habitante de la aldea, por lo que se sugiere su ejecución, como 

obra de inversión que representa un beneficio social. 
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5. Con la construcción de la pasarela que se localizará en la entrada del 

municipio de San Juan Comalapa, se dará ordenamiento a la misma; 

principalmente se brindará seguridad a los peatones que se desplazan 

por el sector, con una inversión de Q 640,755.00; se beneficiará al 90% 

de la población total. 

 
6. Los diferentes perfiles determinados en el diseño de la pasarela se 

consultaron en las diferentes empresas del país para verificar la 

existencia en el mercado, y en caso extremo, que puedan ser laminados.  

 
7. El avance de la tecnología ha permitido que existan programas de 

computación y diversas herramientas que contribuyen al diseño de obras 

de ingeniería específicamente en el área de estructuras metálicas.  Sin 

embargo, es importante revisar los resultados y comprobarlos para 

garantizar un diseño correcto. 

 
8. El estudiante de la Facultad de Ingeniería que opta por hacer Ejercicio 

Profesional Supervisado, se enfrenta a retos que en un futuro se le 

presentarán como profesional, con la ventaja de la asesoría que provee 

la unidad encargada de administrarlo. 
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RECOMENDACIONES 

 

 

A la municipalidad de San Juan Comalapa: 

 

1. Capacitar a los miembros del COCODE de la aldea Cojol Juyú, sobre el 

mantenimiento y operación del sistema de drenaje sanitario, 

asegurándose así la vida útil y un funcionamiento adecuado. 

 

2. Implementar una campaña de educación sanitaria entre la población de 

la aldea Cojol Juyú, sobre la importancia del sistema de drenaje 

sanitario, haciendo énfasis en evitar la deposición de desechos sólidos 

dentro de las tuberías, pues esto puede obstruir el flujo adecuado del 

caudal. 

 

3. La ejecución de ambos proyectos deberán ser supervisados por personal 

calificado, para cumplir con las especificaciones que cada uno de ellos 

demanda, y garantizar los mismos. 

 

4. Actualizar los precios unitarios de cada renglón de trabajo de los 

proyectos previo a la contratación de servicios profesionales, ya que 

están sujetos a variaciones,  debido a factores económicos y de inflación 

en los precios de los materiales y mano de obra. 
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ANEXO 1 

Figura 39. Ensayo de compresión triaxial 
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ANEXO 2 

Diseño hidráulico drenaje sanitario 
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ANEXO 3 

Matriz modificada de Leopold, para el sistema de dr enaje  
sanitario, para la aldea Cojol Juyú  

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Nomenclatura: 
++ Impacto positivo grande     A  adverso 
+   Impacto positivo pequeño    B  benéfico 
*    Neutro       N  neutro 

 -    Impacto negativo pequeño 
 --   Impacto negativo grande 
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ANEXO 4 

Planos drenaje sanitario aldea Cojol Juyú y  
pasarela entrada a cabecera municipal 






































